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FOREWORD

Scope and Intended Audience

Scope. This publication describes how to install and use Avamar client software 
to backup and restore client data.

Intended Audience. The information in this publication is suitable for both 
technical and semi-technical audiences. However, persons installing Avamar client 
software should be familiar with basic application installation procedures and 
practices on that particular computing platform.

Product Information
For current documentation, release notes, software updates, as well as 
information about EMC products, licensing and service, go to the EMC Powerlink 
web site at http://Powerlink.EMC.com.

Your Comments
Your suggestions will help us continue to improve the accuracy, organization and 
overall quality of the user publications. Please send your opinion of this document 
to:

SSGDocumentation@emc.com 

Please include the following information:

• Product name and version
• Document name, part number and revision (for example, A01)
• Page numbers
• Other details that will help us address the documentation issue
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 Notes, Tips and Warnings
FOREWORD
Typeface Conventions
The following table provides examples of standard typeface styles used in this 
publication to convey various kinds of information.

Notes, Tips and Warnings
The following kinds of notes, tips and warnings appear in this publication:

IMPORTANT:  This is a warning. Warnings always contain
information that if not heeded could result in unpredictable
system behavior or loss of data. 

TIP:  This is a tip. Tips present optional information intended
to improve your productivity or otherwise enhance your
experience with our product. Tips never contain information
that will cause a failure if ignored.

NOTE:  This is a general note. Notes contain ancillary infor-
mation intended to clarify a topic or procedure. Notes never
contain information that will cause a failure if ignored.

EXAMPLE DESCRIPTION

Click OK.
 - or -
Select File > Close.

Bold text denotes actual Graphical User Interface 
(GUI) buttons, commands, menus and options (any 
GUI element that initiates action).
Also note in the second example that sequential 
commands are separated by a greater-than (>) 
character. In this example, you are being instructed 
to select the Close command from the File menu.

Type:
 cd /tmp

Bold fixed-width text denotes shell commands that 
must be entered exactly as they appear in this 
publication.

--logfile=FILE All caps text often denotes a placeholder (token) 
for an actual value that must be supplied by the 
user. In this example, FILE would be an actual 
filename. 

Installation Complete. Regular (not bold) fixed-width text denotes 
command shell messages. It is also used to list 
code and file contents.
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BEFORE YOU INSTALL

Before installing any Avamar software, perform the following:

1. Ensure that you have operating system root (Linux and Unix) or 
Administrator (Windows) privileges on the client computer.

2. Ensure that the Avamar server is operational and present on the same 
network as the client computer. 

You can verify this by opening a command shell on the client computer and 
typing the following:

ping AVAMARSERVER

Where AVAMARSERVER is the actual network hostname (as defined in 
DNS) or IP address of your Avamar server.

3. Make note of the actual network hostname (as defined in DNS) for:

(a) Avamar server

(b) Avamar utility node

These DNS entries should have been added during deployment of the 
Avamar system at your site.



INSTALLING/UNINSTALLING AVAMAR AIX CLIENT

This chapter describes how to install and register the Avamar AIX Client software 
on a client computer.

IMPORTANT:  Uninstall (page 14) any previous version of
Avamar AIX Client software before installing the new ver-
sion. 

System Requirements
The client computer on which you want to install the Avamar AIX Client software 
must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • AIX 6.1
• AIX 5.3
• AIX 5.2

Filesystem • JFS

RAM 128 MB.

Hard Drive Space 200 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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 Downloading the Install Package
INSTALLING/UNINSTALLING AVAMAR AIX CLIENT
Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Download the Avamar AIX Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

8. Note the actual filename of the Avamar AIX Client install package. 

NOTE:  AvamarClient-aix5-ppc-VERSION.bff is used as an
example filename for the Avamar AIX Client install package
in the remainder of this chapter. Your actual filename will be
different.
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Installing and Registering the Avamar AIX Client
Log in as root 1. Open a command shell and log in as root.

Install Avamar AIX
Client Software

2. Type:

cd /tmp

geninstall -d AvamarClient-aix5-ppc-VERSION.bff all

Where AvamarClient-aix5-ppc-VERSION.bff is the actual Avamar AIX Client 
install package you previously downloaded (page 11).

The following appears in the command shell:

+----------------------------------------------------------------------------+
Pre-installation Verification...

+----------------------------------------------------------------------------+
Verifying selections...done
Verifying requisites...done
Results...
SUCCESSES
---------

Filesets listed in this section passed pre-installation
verification and will be installed.

Selected Filesets
-----------------

AVMRclnt 5.0-100.400 # Avamar AIX Client 5.0-
100.400...

<< End of Success Section >>

FILESET STATISTICS
------------------

1 Selected to be installed, of which:
1 Passed pre-installation verification

----
1 Total to be installed

Filesystem size changed to 524288

+----------------------------------------------------------------------------+
 Installing Software...
+----------------------------------------------------------------------------+
installp: APPLYING software for:

AVMRclnt 5.0.100.400

. . . . . << Copyright notice for AVMRclnt >> . . . . . . .

This software is copyright EMC 2001-2009.

Please read and agree to the End User License Agreement which will be placed in 
the base directory of the install as a file named AvamarClient-License.txt.

. . . . . << End of copyright notice for AVMRclnt >>. . . .

Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 17444
avagent.d Info: Client Agent started.
Finished processing all filesets. (Total time: 9 secs).
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+----------------------------------------------------------------------------+
Summaries:

+----------------------------------------------------------------------------+

Installation Summary
--------------------

Name Level Part Event Result
-----------------------------------------------------------------------------
AVMRclnt 5.0.100.400 USR APPLY SUCCESS

Register this Client
With the Avamar

Server

3. Type the following:

/usr/local/avamar/bin/avregister

The following appears in the command shell:

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Enter the base directory of the Avamar Client installation [/usr/local/avamar]: 

4. Press ENTER to accept the default base installation directory.

The following appears in the command shell:

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

5. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:

Enter the Avamar server domain [clients]:Avamar

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

6. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Server stopped.
avagent Info <5241>: Logging to ///usr/local/avamar//var/avagent.log
avagent.d Info: Client activated successfully.
avagent.d Info: start
avagent Info <5241>: Logging to ///usr/local/avamar//var/avagent.log
avagent Info <5417>: daemonized as process id 17620
avagent.d Info: Server started.
Registration Complete.
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Uninstalling the Avamar AIX Client
Log in as root 1. Open a command shell and log in as root.

Uninstall Avamar
Software

2. Type:

lslpp -l | grep Avamar

The following appears in the command shell:
AvamarClient-aix5-ppc VERSION COMMITTED EMC Avamar client VERSION

3. Type:

geninstall -u AvamarClient-aix5-ppc

The following appears in the command shell:
+----------------------------------------------------------------------------+

Pre-deinstall Verification...
+----------------------------------------------------------------------------+
Verifying selections...avagent.d Info: Stopping Avamar Client Agent 
(avagent)...
avagent.d Info: Client Agent stopped.
done
Verifying requisites...done
Results...

SUCCESSES
---------

Filesets listed in this section passed pre-deinstall verification
and will be removed.

 Selected Filesets
-----------------
AvamarClient-aix5-ppc  5.0-100.400 # EMC Avamar client 5.0-100.400...

 << End of Success Section >>

FILESET STATISTICS
------------------

1 Selected to be deinstalled, of which:
 1 Passed pre-deinstall verification

----
1 Total to be deinstalled

+----------------------------------------------------------------------------+
Deinstalling Software...

+----------------------------------------------------------------------------+

installp: DEINSTALLING software for:
AvamarClient-aix5-ppc VERSION

Finished processing all filesets. (Total time: 2 secs).

+----------------------------------------------------------------------------+
Summaries:

+----------------------------------------------------------------------------+

Installation Summary
--------------------
Name Level Part Event Result
-----------------------------------------------------------------------------
AvamarClient-aix5-ppc 5.0-100.400 USR DEINSTALL SUCCESS
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Upgrading the Avamar AIX Client
In order to upgrade your Avamar AIX Client software, you must completely 
uninstall the old software (page 14) and install the new software (page 12). 

Manually Stopping and Restarting the avagent Service
The Avamar AIX Client agent (avagent) is configured to run as a service and is 
started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/init.d/avagent stop

Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/init.d/avagent start

Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/init.d/avagent status
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INSTALLING/UNINSTALLING AVAMAR FREEBSD CLIENT

This chapter describes how to install and register the Avamar FreeBSD Client 
software on a client computer.

IMPORTANT:  Uninstall (page 19) any previous version of
Avamar FreeBSD Client software before installing the new
version. 

System Requirements
The client computer on which you want to install the Avamar FreeBSD Client 
software must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System FreeBSD 6.2 (32- and 64-bit)

CPU • 32-bit Intel IA-32
• 64-bit AMD64/EM64T

Filesystem Unix Filesystem (UFS)

RAM 128 MB.

Hard Drive Space 100 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 
12 MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Download the Avamar FreeBSD Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

8. Note the actual filename of the Avamar FreeBSD Client install package. 

NOTE:  AvamarClient-VERSION.freebsd6_64.tbz is used as
an example filename for the Avamar FreeBSD Client install
package in the remainder of this chapter. Your actual file-
name will contain a specific Avamar software VERSION.

Installing and Registering the Avamar FreeBSD Client
Log in as root 1. Open a command shell and log in as root.

Install Avamar
FreeBSD Client

Software

2. Type:

cd /tmp

pkg_add AvamarClient-VERSION.freebsd6_64.tbz 

Where AvamarClient-VERSION.freebsd6_64.tbz is the actual Avamar 
FreeBSD Client install package you previously downloaded (page 17).
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The following appears in the command shell:

Directory to locate cache & log files [/var/avamar]:

3. Do one of the following: 

The following appears in the command shell:

Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 26816
avagent.d Info: Client Agent started.

Register this Client
With the Avamar

Server

4. Type the following:

/usr/local/avamar/bin/avregister

The following appears in the command shell:

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Enter the base directory of the Avamar Client installation [/usr/local/avamar]: 

5. Press ENTER to accept the default base installation directory.

The following appears in the command shell:

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

6. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:

Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

IF DO THIS

You want to locate log files 
in the default location 
(/var/avamar).

Press ENTER to accept the 
default location (/var/avamar)

You want to locate log files 
in an alternative location.

Type the full path of the 
directory you want to contain 
your log files and press ENTER.
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7. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Stopping Avamar Client Agent (avagent)...
avagent.d Info: Client Agent stopped.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent.d Info: Client activated successfully.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 26859
avagent.d Info: Client Agent started.
Registration Complete.

Uninstalling the Avamar FreeBSD Client
Log in as root 1. Open a command shell and log in as root.

Uninstall Avamar
Software

2. Type the following:

pkg_delete AvamarClient

The following appears in the command shell:

avagent.d Info: Stopping Avamar Client Agent (avagent)...
avagent.d Info: Client Agent stopped.
uninstallation successful

Upgrading the Avamar FreeBSD Client
In order to upgrade your Avamar FreeBSD Client software, you must completely 
uninstall the old software (page 19) and install the new software (page 17). 

Manually Stopping and Restarting the avagent Service
The Avamar FreeBSD Client agent (avagent) is configured to run as a service and 
is started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/avagent stop
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Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/avagent restart

Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/rc.d/avagent status
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INSTALLING/UNINSTALLING AVAMAR HP-UX CLIENT

This chapter describes how to install and register the Avamar HP-UX Client 
software on a client computer.

IMPORTANT:  Uninstall (page 25) any previous version of
Avamar HP-UX Client software before installing the new ver-
sion. 

System Requirements
The client computer on which you want to install the Avamar HP-UX Client 
software must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • HP-UX 11i v2 or v3 (IA-64)

CPU • Itanium

Filesystem • HFS
• VxFS

RAM 128 MB.

Hard Drive Space 200 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Download the Avamar HP-UX Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

8. Note the actual filename of the Avamar HP-UX Client install package. 

NOTE:  AVAMARHPUX.depot is used as an example filename
for the Avamar HP-UX Client install package in the remainder
of this chapter. Your actual filename will be different.
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Installing and Registering the Avamar HP-UX Client
Log in as root 1. Open a command shell and log in as root.

Install Avamar HP-
UX Client Software

2. Change directory to your temporary install directory (page 22). For 
example:

cd /tmp

3. Type the following:

swinstall -s /tmp/AVAMARHPUX.depot \*

Where AVAMARHPUX.depot is the actual filename of the Avamar HP-UX 
Client install package you previously downloaded (page 22).

The following appears in the command shell:

======= 02/03/06 16:12:23 PST BEGIN swinstall SESSION (non-interactive)

* Session started for user "root@hp-ux-01". 
* Beginning Selection
* Target connection succeeded for "hp-ux-01:/".
* Source:

AVAMARHPUX.depot
* Targets:

hp-ux-01:/
* Software selections:

hpuxclnt.hpuxclnt-exec,r=5.0-100.400,a=HP-UX_B.11.00_32/64
* Selection succeeded.
* Beginning Analysis
* Session selections have been saved in the file

"/.sw/sessions/swinstall.last".
* The analysis phase succeeded for "hp-ux-01:/".
* Analysis succeeded.
* Beginning Execution
* The execution phase succeeded for "hp-ux-01:/".
* Execution succeeded.

NOTE: More information may be found in the agent logfile (location ishp-ux-01:/
var/adm/sw/swagent.log).

======= 02/03/06 16:13:46 PST END swinstall SESSION (non-interactive)

Register this Client
With the Avamar

Server

4. Type the following:

/opt/AVMRclnt/bin/avregister

The following appears in the command shell:

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Enter the base directory of the Avamar Client installation [/opt/AVMRclnt]: 

5. Press ENTER to accept the default base installation directory.

The following appears in the command shell:

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):
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6. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:
Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

7. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Server stopped.
avagent Info <5241>: Logging to ///opt/AVMRclnt//var/avagent.log
avagent.d Info: Client activated successfully.
avagent.d Info: start
avagent Info <5241>: Logging to ///opt/AVMRclnt//var/avagent.log
avagent Info <5417>: daemonized as process id 17620
avagent.d Info: Server started.
Registration Complete.
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Uninstalling the Avamar HP-UX Client
Log in as root 1. Open a command shell and log in as root.

Uninstall Avamar
Software

2. Type the following:

swremove hpuxclnt

The following appears in the command shell:

======= 02/03/06 16:09:29 PST BEGIN swremove SESSION (non-interactive)

* Session started for user "root@hp-ux-01".
* Beginning Selection
* Target connection succeeded for "hp-ux-01:/".
* Software selections:

hpuxclnt.hpuxclnt-exec,l=/opt/AVMRclnt,r=5.0-100.400,
a=HP-UX_B.11.00_32/64

* Selection succeeded.
* Beginning Analysis
* Session selections have been saved in the file

"/.sw/sessions/swremove.last".
* The analysis phase succeeded for "hp-ux-01:/".
* Analysis succeeded.
* Beginning Execution
* The execution phase succeeded for "hp-ux-01:/".
* Execution succeeded.

NOTE: More information may be found in the agent logfile (location is hp-ux-
01:/var/adm/sw/swagent.log).

======= 02/03/06 16:09:45 PST END swremove SESSION (non-interactive)

Upgrading the Avamar HP-UX Client
In order to upgrade your Avamar HP-UX Client software, you must completely 
uninstall the old software (page 25) and install the new software (page 23). 

Manually Stopping and Restarting the avagent Service
The Avamar HP-UX Client agent (avagent) is configured to run as a service and is 
started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/sbin/init.d/avagent stop
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Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/sbin/init.d/avagent restart

Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/sbin/init.d/avagent status
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INSTALLING/UNINSTALLING AVAMAR LINUX CLIENT

This chapter describes how to install and register the Avamar Linux Client software 
on a client computer.

IMPORTANT:  Uninstall (page 30) any previous version of
Avamar Linux Client software before installing the new ver-
sion. 

System Requirements
The client computer on which you want to install the Avamar Linux Client software 
must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • Red Hat Enterprise Linux Release 5 (32- and 64-bit)
• Red Hat Enterprise Linux Release 4 (32- and 64-bit)
• Red Hat Enterprise Linux Release 3 (32- and 64-bit)
• Red Hat Linux Release 9
• SUSE Linux Enterprise Server 10, 9, 8.2 (32- and 64-

bit)
IMPORTANT:  32-bit Red Hat Enterprise Linux Release 5 
systems must also install Red Hat LIBC-5 compatibility 
libraries in order to use Avamar Linux Client software.

CPU • x86

Filesystem • ext2
• ext3
• JFS
• ReiserFS

RAM 128 MB.
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Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Download the Avamar Linux Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

8. Note the actual filename of the Avamar Linux Client install package. 

NOTE:  AVAMARLINUX.rpm is used as an example filename
for the Avamar Linux Client install package in the remainder
of this chapter. Your actual filename will be different.

Hard Drive Space 100 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.

REQUIREMENT MINIMUM
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Customizing the Install Location
This topic describes how to install the Avamar Linux Client somewhere other than 
the default location.

Environment
Variable

To customize the var directory location, set AVAMAR_INSTALL_VARDIR_PATH to 
the desired location before beginning the installation procedure.

rpm --relocate You can also change the base installation directory using the rpm --relocate 
option during installation. For example:

rpm -ih --relocate /usr/local/avamar=NEW_PATH AVAMARLINUX.rpm

Where /usr/local/avamar is the default installation directory, NEW_PATH is the 
new (non-default) installation directory and AVAMARLINUX.rpm is the actual 
filename of the Avamar Linux Client install package you previously downloaded 
(page 28).

IMPORTANT:  The rpm --relocate feature requires Red
Hat Package Manager version 4.0.3 or higher.

Installing and Registering the Avamar Linux Client
Log in as root 1. Open a command shell and log in as root.

Install Avamar
Linux Client

Software

2. Change directory to your temporary install directory (page 28). For 
example:

cd /tmp

3. Type the following:

rpm -ih AVAMARLINUX.rpm

Where AVAMARLINUX.rpm is the actual filename of the Avamar Linux 
Client install package you previously downloaded (page 28).

The following appears in the command shell:

########################################### [100%]
########################################### [100%]
Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 2066
avagent.d Info: Client Agent started.

Register and
Activate this Client

With the Avamar
Server

4. Type the following:

/usr/local/avamar/bin/avregister

The following appears in the command shell:

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.
Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):
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5. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:
Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

6. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Client Agent stopped. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent.d Info: Client activated successfully. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 3385
avagent.d Info: Client Agent started. [ OK ]
Registration Complete.

Uninstalling the Avamar Linux Client
Log in as root 1. Open a command shell and log in as root.

Uninstall Avamar
Software

2. Type the following:

rpm -qa | grep Av

The following appears in the command shell:

EMCClient-VERSION

3. Note the full package name.

4. Type the following:

rpm -e EMCClient-VERSION

Where EMCClient-VERSION is the Avamar software install package 
returned in step 3.

The following appears in the command shell:

avagent.d Info: Client Agent stopped.
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Upgrading the Avamar Linux Client
In order to upgrade your Avamar Linux Client software, you must completely 
uninstall the old software (page 30) and install the new software (page 29). Use of 
the Linux software upgrade command (rpm -Uh) is not supported.

Manually Stopping and Restarting the avagent Service
The Avamar Linux Client agent (avagent) is configured to run as a service and is 
started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Do one of the following: 

Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Do one of the following: 

IF DO THIS

Stopping the avagent service on any 
version Red Hat Linux or SUSE Linux 
Enterprise Server 10.

Type the following:
service avagent stop

Stopping the avagent service on SUSE 
Linux Enterprise Server 9 or 8.2.

Type the following:
/etc/rc.d/avagent stop

IF DO THIS

Restarting the avagent service on any 
version Red Hat Linux or SUSE Linux 
Enterprise Server 10.

Type the following:
service avagent restart

Restarting the avagent service on SUSE 
Linux Enterprise Server 9 or 8.2.

Type the following:
/etc/rc.d/avagent restart
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Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Do one of the following: 

IF DO THIS

Getting avagent status on any version 
Red Hat Linux or SUSE Linux Enterprise 
Server 10.

Type the following:
service avagent status

Getting avagent status on SUSE Linux 
Enterprise Server 9 or 8.2.

Type the following:
/etc/rc.d/avagent status
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This chapter describes how to install and register Avamar Mac OS X Client 
software on a client computer.

System Requirements
The client computer on which you want to install the Avamar Mac OS X Client 
software must meet the following minimum requirements: 

IMPORTANT:  The default process data size limit on Mac OS
X (6 MB) is lower than the EMC recommended limit of 96 MB.

To set this correctly for use with the Avamar Mac OS X Cli-
ent, add the following entry to your /etc/launchd.conf file
and restart your computer:

limit data 100663296 unlimited

REQUIREMENT MINIMUM

Operating System • Apple Mac OS X v10.5 Leopard
• Apple Mac OS X v10.4 Tiger
• Apple Mac OS X Server v10.5 Leopard
• Apple Mac OS X Server v10.4 Tiger

RAM 512 MB.

Hard Drive Space 250 MB permanent hard drive space (1 GB recommended) 
for software installation.

The Avamar client software also requires an additional 
12MB of permanent hard drive space for each 64 MB of 
physical RAM. Additional disk space might be required by 
your snapshot technology.

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Installing the Avamar Mac OS X Client
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Double-click the AvamarClient-macosx-uni-VERSION.pkg.zip file.

Your browser will prompt you to either open the file “in-place” (on the 
server) or save it to your local computer.

8. Save AvamarClient-macosx-uni-VERSION.pkg.zip to your computer 
desktop.

9. Double-click the AvamarClient-macosx-uni-VERSION.pkg.zip file.

The zip file is extracted to the AvamarClient-VERSION.MacOSX.uni.mpkg 
file on your desktop.

10.Double-click AvamarClient-VERSION.MacOSX.uni.mpkg to begin installing 
the Avamar Mac OS X Client software.

The installation wizard starts and the Welcome screen appears.

11.Click Continue.

The Software License Agreement appears.

12.Read the Software License Agreement and click Continue.

The Disagree/Agree dialog appears.

13.Select Agree.

The Select a Destination screen appears.

14.Select the installation destination and click Continue.

The Easy Install screen appears.
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15.Do one of the following: 

16.Select Customize.

The Custom Install screen appears.

17.Select Desktop/Laptop Support and click Install.

The Authenticate dialog appears.

18. Type the name and password for a user account with administrator 
privileges on the computer and click OK.

The software is installed and the successful install screen appears.

19.Click Close.

The Avamar Desktop/Laptop software is installed, and is ready for 
registration and activation as described in Registering the Avamar Mac OS 
X Client (page 36).

IF DO THIS

You want to install enhanced 
desktop/laptop support.

Go to step 16.

You do not want to install enhanced 
desktop/laptop support.

Skip steps 16 and 17. 
Go directly to step 18.
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Registering the Avamar Mac OS X Client
Before you can backup or restore any files on this client computer, you must 
register it with the Avamar server.

1. Launch the Activate Client Setup dialog box:

• Use the context menu of the Avamar icon on the Dock and click Activate.
• From the AvamarClient menu bar in the AvamarClient application, select 

Actions > Activate.

2. Type the following:

3. Click Activate.

FIELD DESCRIPTION

Administrator 
Server Address

Administrator server network hostname as defined 
in DNS.

Client Domain Avamar domain where you want this client to reside.
The default domain is “clients.” However, your 
Avamar system administrator may have defined 
other domains and subdomains. Consult your 
Avamar system administrator for the specific domain 
you should use when registering this client.
IMPORTANT:  If typing a subdomain (for example, 
clients/MyClients), do not include a slash (/) as the 
first character. Including a slash as the first 
character will cause an error and prevent you from 
registering this client.

Client User 
Access List (UAL)

Not used.
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Uninstalling the Avamar Mac OS X Client
Uninstalling the Avamar Mac OS X Client is accomplished by running the 
avuninstall.sh script.

Log in as root 1. Open a terminal window and log in as root.

2. Run the avuninstall.sh script by typing:

/usr/local/avamar/bin/avuninstall.sh

The following appears in the command shell:
./avuninstall.sh: line 26: /usr/local/avamar/bin/avregister: Permission denied
Warning: Cannot unregister avagent.
/usr/local/avamar/var/avagent.lck
/usr/local/avamar/var/cid.bin
/usr/local/avamar/var/avagent.cfg
/usr/local/avamar/var/avagent.log
/usr/local/avamar/bin/avagent.bin
/usr/local/avamar/bin/avregister
/usr/local/avamar/bin/avrunner
/usr/local/avamar/bin/avtar.bin
/usr/local/avamar/bin/avuninstall.sh
/usr/local/avamar/bin/macosx.pin
/usr/local/avamar/var
/usr/local/bin/avtar
rmdir: /var/avamar: Directory not empty
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Archive.bom
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Info.plist
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/PkgInfo
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
AxionClient-1.0.bom
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
AxionClient-1.0.sizes
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
BundleVersions.plist
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
English.lproj/AxionClient-1.0.info
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
English.lproj/Description.plist
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
English.lproj
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
License.html
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
package_version
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
postflight
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
preflight
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
ReadMe.html
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources/
Welcome.html
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents/Resources
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg/Contents
/Library/Receipts/AvamarClient-VERSION.MacOSX.uni.mpkg
/Library/LaunchDaemons/com.avamar.avagent.plist
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Upgrading the Avamar Mac OS X Client
In order to upgrade your Avamar Mac OS X Client software, you must completely 
uninstall the old software (page 37) and install (page 34) and register (page 36) 
the new software.
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This chapter describes how to install and register Avamar NetWare Client software 
on a Novell NetWare server.

System Requirements
The client computer on which you want to install the Avamar NetWare Client 
software must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System OES (Open Enterprise Server) NetWare 6.5 SP6, SP7 or 
SP8 (x86)

Filesystem NSS (Novell Storage Services)

RAM 4 GB.

Hard Drive Space 200 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Capabilities and Limitations
This topic explains the current capabilities and limitations of the Avamar NetWare 
Client. 

Directory and File Metadata. The Avamar NetWare Client protects NetWare 
directory and file metadata as follows:

• Basic attributes are protected and recovered
• Trustee assignments are protected and recovered
• Inherited Rights Filters are protected and recovered

NSS Compression Should Be Suspended During Backups. NSS volumes 
with compression enabled can cause memory contention issues during backups. 
The avtar --suspend_nss_compression backup option, which is enabled by 
default, will automatically suspend NSS compression during backups and 
automatically resume NSS compression following backups. Therefore, EMC 
strongly recommends that you do not disable this option during your backup 
operations.

Encryption Is Not Supported.  The Avamar NetWare Client does not support 
encryption for backup or restore operations. If an encryption method other than 
“None” is specified for a backup or restore, Avamar automatically changes the 
encryption method to “None.”

Important Memory Allocation Information
Beginning with version 4.1.105, the Avamar NetWare Client reserves a block of 
NetWare server memory (512MB is the default amount) for performing Avamar 
backups. This reserved memory space is automatically allocated each time the 
Avamar backup agent service (avagent) is started or restarted.

The initial memory allocation is logged in the avagent.log file with entries similar 
to the following: 

avagent Info <0000>: Allocating 512 MBs for shared heap (PhysicalRAM=3987 MB, 
Avail=1582 MB)
avagent Info <0000>: Shared Heapbase=0x03437680

NOTE:  Your actual PhysicalRAM, Avail and the Shared
Heapbase values will be different.

Once avagent has allocated the reserved memory (512MB is the default amount), 
it is not accessible to other applications on the NetWare server. This memory is 
strictly reserved for use by the Avamar backup process (avtar).

When a backup or restore is performed using Avamar Administrator, the shared 
heap location is automatically transferred from avagent to avtar, and the 
reserved memory space is used for all future Avamar backups and restores on this 
NetWare server. This can be seen in the avtar.log file with an entry similar to: 

avtar Info <0000> Using Shared Heap Storage: 512 MBs at address 0x03437680

As with avagent.log file, your actual Shared Heap address will be different.
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The agentsharedheap.cfg File. In addition to logging memory allocation in the 
avagent.log file, avagent also creates the agentsharedheap.cfg file in 
SYS:AVAMAR/VAR/. This file stores memory allocation settings for that avagent 
session (it is removed each time avagent exits). 

If avtar cannot complete the backup or restore within the reserved Shared Heap 
space, it will exit with an Out of Memory error.

Invoking avtar Directly. If the Avamar backup process (avtar) is invoked 
directly on the NetWare client (for example, from within a script file or a command 
prompt), the following additional option must be included on each avtar 
command line:

--flagfile=SYS:AVAMAR/VAR/agentsharedheap.cfg

SYS:AVAMAR/VAR is the default location where agentsharedheap.cfg should exist 
on most systems. If your actual location is different, include the correct path to 
agentsharedheap.cfg.

Changing the Size of the Reserved Shared Heap

The default amount of reserved memory is 512MB. If you would like to increase 
this, you must create an avagent.cmd file in SYS:AVAMAR/VAR and add the 
following entry:

--sharedheapsize=MB 

For example, to change the reserved shared heap space to 600 MB, the following 
entry should be placed in the avagent.cmd file:

--sharedheapsize=600

IMPORTANT:  Although, it is possible to configure the
amount of reserved memory to be less than 512MB, EMC
strongly advises against doing so as it might compromise
the operational integrity and readiness of the Avamar
backup process.

After making your changes to your avagent.cmd file, you must stop, then restart 
avagent in order for this change to take effect. Refer to Manually Stopping and 
Restarting the avagent Service (page 50) for additional information.

Note that avagent by default will refuse to allocate more than one-half of the total 
amount of physical RAM or available memory. In order to force avagent to allocate 
the specified amount, even if it exceeds the 50% limitation, you must also add the 
following additional entry to your avagent.cmd file:

--x21=512

However, be advised that overriding the 50% limitation can cause adverse 
behavior such as NetWare ABEND errors when avagent is started or restarted.
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Troubleshooting

The Avamar NetWare Client software installation program appends the following 
entries at the end of the SYS:\SYSTEM\AUTOEXEC.NCF.

# Added by Avamar Client Install
SYS:\AVAMAR\BIN\AVCTL.NLM start

There might be situations when avagent is unable to secure the 512 MB of 
memory when the NetWare server is booting up. This is typically caused by other 
applications and essential operating system components competing for the same 
memory that the Avamar NetWare Client is attempting to allocate.

If this occurs, edit the AUTOEXEC.NCF and move the Avamar NetWare Client 
entries earlier in the load order.

The following example file listing shows a typical AUTOEXEC.NCF file with Avamar 
NetWare Client entries appended to the end of the file (the default location in the 
load order for these entries):

set Bindery Context = O=dev
SET Daylight Savings Time Offset = 1:00:00
SET Start Of Daylight Savings Time = (MARCH SUNDAY SECOND 2:00:00 AM)
SET End Of Daylight Savings Time = (NOVEMBER SUNDAY FIRST 2:00:00 AM)
SET Time Zone = EST5EDT
# Note: The Time zone information mentioned above
# should always precede the SERVER name.
SEARCH ADD SYS:\JAVA\BIN
SEARCH ADD SYS:\JAVA\NWGFX\BIN
SEARCH ADD SYS:\JAVA\NJCLV2\BIN
SEARCH ADD SYS:\NI\UPDATE\BIN
# WARNING!!
FILE SERVER NAME CLINW1
# WARNING!!
# If you change the name of this server, you must update
# the server name in all the licenses that are assigned
# to it using iManager.
LOAD CONLOG MAXIMUM=100
LOAD TCPIP
LOAD PCNTNW.LAN PCI SLOT=3 FRAME=ETHERNET_II NAME=PCNTNW_1_EII
BIND IP PCNTNW_1_EII addr=10.6.248.190 mask=255.255.255.0 gate=10.6.248.1
MOUNT ALL
IPMINIT.NCF
SYS:\SYSTEM\NMA\NMA5.NCF
BSTART.NCF
load nile.nlm
load httpstk.nlm /SSL /keyfile:"SSL CertificateIP"
LOAD PORTAL.NLM
LOAD NDSIMON.NLM
LOAD NICISDI.XLM
LOAD SASDFM.XLM
# -- Added by AFP Install --
AFPSTRT.NCF
# -- End of AFP Install --
# -- Added by CIFS Install --
CIFSSTRT.NCF
# -- End of CIFS Install --
SYS:/BIN/UNIXENV.NCF
LOAD PKI.NLM
LOAD NLDAP.NLM
# -- Added by Scripting Install --
SCRIPT.NCF
SEARCH ADD SYS:\APACHE2
#ACCESS TO XTIER SOFTWARE
SEARCH ADD SYS:\XTIER
LOAD NCPL
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AP2WEBUP
#Apache2 is now the admin server
ADMSRVUP
# tc4admin begin
SEARCH ADD SYS:/tomcat/4/bin
tcadmup.ncf
# tc4admin end
# tomcat4 begin
sys:/tomcat/4/bin/tomcat4.ncf
# tomcat4 end
# tomcat5 begin
SEARCH ADD SYS:/tomcat/5.0/bin
sys:/tomcat/5.0/bin/tomcat5.ncf
# tomcat5 end
# Storage Management Services components required for Backup
SMSSTART.NCF
#Added By FTP Server
ftpstart.ncf
#Added By FTP Server END
#---Added By Native File Access For Unix---
nfsstart
#---Added By Native File Access For Unix END---
LOAD EMBOX.NLM
# -- Added by MYSQL Install --
SEARCH ADD SYS:\mysql\bin
mysqld_safe --autoclose
# -- End of MYSQL Install --
openwbem.ncf
LOAD RDBHOST.NLM
LOAD TOOLBOX.NLM
LOAD MONITOR.NLM
# Added by Avamar Client Install
SYS:\AVAMAR\BIN\AVCTL.NLM start

IMPORTANT:  The AUTOEXEC.NCF file is a critical operating
system configuration file. Be very careful when making mod-
ifications in order to ensure that the server is able to boot up
and initialize properly.

The AUTOEXEC.NCF file is a text file that can be edited from a Windows client with 
a mapped drive to the NetWare server SYS volume. It can also be modified from 
the NetWare server console using either the NWConfig Console or directly from 
the Edit Console.

IMPORTANT:  The Avamar NetWare Client has dependen-
cies on Novell Storage Management Services (SMS). There-
fore, ensure that the entry for SMSSTART.NCF occurs prior to
SYS:\AVAMAR\BIN\AVCTL.NLM start entry in the 
AUTOEXEC.NCF load order.
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NOTE:  Because each customer environment is different,
EMC cannot offer any definitive suggestions regarding the
optimum location for the Avamar NetWare Client entries in
the load order. Each NetWare administrator must determine
the best location in the load order on each individual Net-
Ware server. 

To modify AUTOEXEC.NCF using the NWConfig Console:

1. From the NetWare server console, type Load NWConfig.NLM and press 
ENTER. 

The NWConfig Console appears.

2. Select NCF Files Options > Edit AUTOEXEC.NCF file. 

The AUTOEXEC.NCF file appears in the Edit Console window.

3. Move the Avamar NetWare Client entries from the end of the file to earlier 
in the load order.

4. Save your changes and exit the AUTOEXEC.NCF editing session.

5. Reboot the NetWare server.

6. Verify that the AVAGENT Console is loaded. 

IMPORTANT:  Do not select Create AUTOEXEC.NCF file or
Create STARTUP.NCF file. Doing so will adversely impact
your file server and could prevent it from properly initializing
during start up. If you mistakenly select either of these com-
mands, immediately escape (press ESC) without saving.

To modify AUTOEXEC.NCF directly from the Edit Console:

1. From the NetWare server console, type 
Load Edit.NLM SYS:\System\AUTOEXEC.NCF and press ENTER. 

The AUTOEXEC.NCF file appears in the Edit Console window.

2. Move the Avamar NetWare Client entries from the end of the file to earlier 
in the load order.

3. Save your changes and exit the AUTOEXEC.NCF editing session.

4. Reboot the NetWare server.

5. Verify that the AVAGENT Console is loaded. 
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Installing the Avamar NetWare Client
Unless your NetWare server has an HTTP connection to the Avamar server, you will 
not be able to directly download the Avamar NetWare Client software install 
package to the NetWare server.

In order to support the broadest range of NetWare environments, this publication 
instructs you to download and install Novell client software on a Windows 
computer on the same network as the NetWare server, then map the NetWare 
server SYS volume to a Windows drive letter. You will then be able to download 
the Avamar NetWare Client software install package and copy it over to the 
NetWare server, where it can be installed from the NetWare server system 
console.

Therefore, in most cases to successfully install and configure the Avamar NetWare 
Client software directly on a Novell NetWare server, you must perform all of the 
following tasks in the following order:

• Download and Install Novell Server Updates (page 45)
• Download and Install Novell Client Software (page 46)
• Download the Avamar NetWare Client Software Install Package (page 48)
• Install and Register Avamar NetWare Client Software (page 48)

Download and Install Novell Server Updates

In order to ensure adequate performance and stability during backup and restore 
operations, EMC strongly recommends that you install the following Novell 
updates on your NetWare 6.5 SP6, SP7 and SP8 Servers:

NetWare 6.5 SP 6 Servers

1. Install each required update in the following order by pointing your web 
browser to the location listed in the instructions column for each update. 

2. Follow the detailed download and installation instructions provided by 
Novell for each respective update.

UPDATE INSTRUCTION

Winsock http://download.novell.com/
Download?buildid=qxJni5EswNU~

CIMOM http://download.novell.com/
Download?buildid=LaqVAPb33l0~

LibC http://download.novell.com/
Download?buildid=3zlJxNGW9n4~

MM http://download.novell.com/
Download?buildid=_Zr_v9QAoFA~
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NetWare 6.5 SP 7 Servers

1. Install each required update in the following order by pointing your web 
browser to the location listed in the instructions column for each update.

2. Follow the detailed download and installation instructions provided by 
Novell for each respective update.

NetWare 6.5 SP 8 Servers

1. Install each required update in the following order by pointing your web 
browser to the location listed in the instructions column for each update.

2. Follow the detailed download and installation instructions provided by 
Novell for each respective update.

Download and Install Novell Client Software
1. Log into a Windows computer on the same network as the NetWare server.

2. Download the Novell client software from the Novell web site 
(www.novell.com).

3. Install the Novell client software by following the instructions provided by 
Novell.

4. Map the NetWare server SYS volume to a Windows drive letter by 
performing the following:

(a) Right-click the Novell client system tray icon and select 
Novell Map Network Drive...

The Map Drive dialog box appears.

UPDATE INSTRUCTION

COMN.NSS http://download.novell.com/
Download?buildid=vgIJ013SZ8c~

WINSOCK http://download.novell.com/
Download?buildid=qxJni5EswNU~

TCP http://download.novell.com/
Download?buildid=6fH3feVnmQM~

UPDATE INSTRUCTION

NSS http://download.novell.com/
Download?buildid=jq51Wf0qquA~

MM http://download.novell.com/
Download?buildid=el6hX1lumoo~
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(b) Select or type the following:

(c) Click OK.

The Map Drive dialog box closes.

If you are not already logged into the Novell NetWare server, a Novell 
Login dialog box appears.

If this occurs, you must log into the Novell NetWare server using the 
admin user account and password.

(d) Ensure that admin appears in the Username field.

(e) Type the password for the admin user account in the Password field.

(f) Click OK.

The Novell Login dialog box closes. 

FIELD/OPTION DESCRIPTION

Select the drive letter to map Select one of the available drive 
letters from this list.

Type the network path to the 
resource

Type the full network path to the 
NetWare server SYS volume 
using the following UNC syntax:

\\NETWARE-SERVER\SYS

Where NETWARE-SERVER are 
the actual IP address or 
hostname, as defined in 
corporate DNS, of your NetWare 
server.

Type your network user name Type admin.

Check to make folder appear 
as the top most level

Select this option.

Check to always map this 
drive letter when you start 
Windows

Leave this option cleared.

Map Search drive Leave this option cleared.
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Download the Avamar NetWare Client Software Install Package
1. From the Windows computer that you used to perform the previous task, 

point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

2. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

3. Page down until the Documents and Downloads hyperlink is visible.

4. Click Documents and Downloads.

The Documents and Downloads page appears.

5. Click the Novell NetWare 6.5 hyperlink.

A directory listing appears in your browser.

6. Click the AvamarClient-VERSION.Netware6.zip install package.

Your browser will prompt you to either open the file “in-place” (on the 
server) or save it to your local computer. For this procedure, you must save 
the file to a convenient temporary folder (directory) within the NetWare 
server SYS volume.

7. Save the AvamarClient-VERSION.Netware6.zip install package to a 
convenient temporary folder (directory) within the NetWare server SYS 
volume.

8. Note this location for future use.

Install and Register Avamar NetWare Client Software
1. Ensure that you are still logged into the Windows computer that you used 

to perform the previous tasks.

2. From Windows Explorer, browse to the temporary folder (directory) within 
the NetWare server SYS volume where you downloaded the file from the 
previous task.

3. Unzip the AvamarClient-VERSION.Netware6.zip install package.

The unzip operation will automatically extract the contents to a folder 
(directory) called AVCLNT.

4. Copy the entire AVCLNT folder (directory) to the NetWare server SYS 
volume top-level (root) folder (directory).

The remainder of this procedure is performed from the NetWare server 
system console.

TIP:  The Novell rconj.exe utility can be used to remotely
access the NetWare server system console.

5. From the NetWare server system console, load NWCONFIG.NLM.
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6. Select Product Options > Install a product not listed.

7. Type:

SYS:AVCLNT

A license prompt appears.

8. Press ESC to acknowledge the license. 

9. Select yes and press ENTER to accept the license agreement.

10.Accept the default response to register the client.

11. If registration was selected, the following appears:

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.
Enter the Administrator server address (DNS text name, not numeric IP address) 
below.

Enter the Administrator server address:

12.Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears:

Enter the Avamar server domain:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

13. Press ENTER to accept the default domain (clients).

A confirmation prompt appears.

14. Press ENTER to acknowledge the installation completion message.

Following step 14, screen focus typically switches to the NetWare server 
system console.

15.Switch to the NWconfig screen and press ENTER to complete this 
procedure.
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Manually Stopping and Restarting the avagent Service
Although the Avamar NetWare Client should be fully functional after performing 
the installation procedure (page 45), you can access additional client controls that 
can be used to start or stop the Avamar NetWare Client service, as well as register 
or unregister the Avamar NetWare Client with an Avamar server. 

This entire procedure is performed from the NetWare server system console.

TIP:  The Novell rconj.exe utility can be used to remotely
access the NetWare server system console.

1. From the NetWare server system console, load NWCONFIG.NLM.

2. Select Product Options > View/Configure/Remove installed 
products. 

3. Select AVACLNT and press ENTER. 

The following appears:

=== Please select an option from the menu below:

s Start Avamar Client Agent
t Stop Avamar Client Agent
r Register Avamar Client
u Unregister Avamar Client

q Quit

Enter an option [struq]:

4. Do one of the following:

5. When you are finished, type q and press ENTER to quit the control 
application.

IF DO THIS

You want to start or restart the Avamar 
NetWare Client service.

Type s and press ENTER.

You want to stop the Avamar NetWare 
Client service.

Type t and press ENTER.

You want to register the Avamar NetWare 
Client with an Avamar server.

Type r and press ENTER.

You want to unregister the Avamar 
NetWare Client from an Avamar server.

Type u and press ENTER.
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Uninstalling the Avamar NetWare Client
This entire procedure is performed from the NetWare server system console.

TIP:  The Novell rconj.exe utility can be used to remotely
access the NetWare server system console.

1. From the NetWare server system console, load NWCONFIG.NLM.

2. Select Product Options > View/Configure/Remove installed 
products. 

3. Select AVACLNT and press DELETE. 

This will stop, unregister and remove the Avamar NetWare Client.

The following appears:

===============================
"Remove product AVACLNT?"
No
Yes
===============================

4. Select Yes.

The following appears:

<NLM has terminated; press any key to close screen.>

5. Press any key to close this window.

6. Switch to the avctl screen and press ENTER to complete this procedure. 

Upgrading the Avamar NetWare Client
In order to upgrade your Avamar NetWare Client software, you must completely 
uninstall the old software (page 51) and install the new software (page 45). 
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This chapter describes how to install and register the Avamar SCO Client software 
on a client computer.

IMPORTANT:  Uninstall (page 62) any previous version of
Avamar SCO Client software before installing the new ver-
sion. 

System Requirements
The client computer on which you want to install the Avamar SCO Client software 
must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • SCO Open Server 5.0.7
• SCO Open Server 5.0.5
• SCO UnixWare 7.1.3

Filesystem • OpenServer – HTFS, EAFS, DTFS, AFS, S51K
• UnixWare – SFS, S5, BFS, VxFS, UFS

RAM 128 MB.

Hard Drive Space 200 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
 AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  52



 Downloading the Install Package
INSTALLING/UNINSTALLING AVAMAR SCO CLIENT
Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Do one of the following: 

Where VERSION is the specific version Avamar SCO Client software you are 
installing.

8. Download the Avamar SCO Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

9. Note the actual filename of the Avamar SCO Client install package. 

NOTE:  AvamarClient-sco5.0.5-i386-VERSION.pkg is used
as an example filename for the Avamar SCO Client install
package in the remainder of this chapter. Your actual file-
name will be different.

IF DO THIS

Installing SCO Open 
Server 5.0.5 or 5.0.7.

Use install package 
AvamarClient-sco5.0.5-i386-VERSION.pkg

Installing UnixWare 
7.1.3.

Use install package 
AvamarClient-unixware7.1.1-i386-VERSION.pkg
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  53



 Installing and Registering the Avamar SCO Client
INSTALLING/UNINSTALLING AVAMAR SCO CLIENT
Installing and Registering the Avamar SCO Client

NOTE:  This procedure demonstrates how to install Avamar
SCO Client software on SCO Open Server 5.0.5 or 5.0.7. The
procedure is substantially the same for installing Avamar
SCO Client software on UnixWare 7.1.3. However, the install
package name, specific files installed, and so forth will be
slightly different.

Log in as root 1. Open a command shell and log in as root.

Install Avamar
SCO Client

Software

2. Type:

cd /tmp

pkgadd -d - < AvamarClient-sco5.0.5-i386-VERSION.pkg

Where AvamarClient-sco5.0.5-i386-VERSION.pkg is the actual Avamar 
SCO Client install package you previously downloaded (page 53).

The following appears in the command shell:

The following packages are available:

1 Avamar AvamarClient
(i386) 5.0-100.400

Select package(s) you wish to process (or 'all' to process
all packages). (default: all) [?,??,quit]: 

PROCESSING:
Package: AvamarClient (Avamar) from <->.

AvamarClient
(i386) 5.0-100.400
Using </usr/local> as the package base directory.
## Processing package information.
## Processing system information.
## Verifying disk space requirements.

Installing AvamarClient as <Avamar>

## Executing preinstall script.
Directory to locate cache & log files [/var/avamar]: 
Confirm '/var/avamar' is the desired location. [n]

3. Type y and press ENTER.

The following appears in the command shell:

## Installing part 1 of 1.
/usr/local/avamar/bin/avagent.bin
/usr/local/avamar/bin/avregister
/usr/local/avamar/bin/avtar
/usr/local/avamar/bin/avtar.bin
/usr/local/avamar/bin/unix.pin
/usr/local/avamar/etc/avagent.d
/usr/local/avamar/lib/libpthread.so.20
[ verifying class <none> ]
## Executing postinstall script.
Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
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avagent Info <5417>: daemonized as process id 4318
avagent.d Info: Client Agent started.

Installation of AvamarClient (Avamar) was successful.

Register this Client
With the Avamar

Server

4. Type the following:

/usr/local/avamar/bin/avregister

The following appears in the command shell:
=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Enter the base directory of the Avamar Client installation [/usr/local/avamar]: 

5. Press ENTER to accept the default base installation directory.

The following appears in the command shell:

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

6. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:

Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example, 
clients/MyClients), do not include a slash (/) as the first
character. Including a slash as the first character will cause
an error and prevent you from registering this client.

7. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Stopping Avamar Client Agent (avagent)...
avagent.d Info: Agent not yet terminated (15 seconds), please wait.
avagent.d Info: Agent not yet terminated (30 seconds), please wait.
avagent.d Info: Agent not yet terminated (45 seconds), please wait.
avagent.d Info: Client Agent stopped.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent.d Info: Client activated successfully.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 4878
avagent.d Info: Client Agent started.
Registration Complete.
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Additional SCO 5.0.5 Configuration and Setup
If you intend to use Avamar SCO Client software on SCO 5.0.5 and you require 
network socket encryption during backup and restore operations, you must install 
the following packages:

• OS Supplement (oss646c)
• GWX libs (gwxlibs-2.1.0Ba)
• OpenSSH (openssh-4.2p1)

Log in as root 1. Open a command shell and log in as root.

Create Temporary
Directories

2. Next, create temporary directories that will be used to download and 
extract the SCO packages by typing:

cd /tmp

mkdir supplement gwx openssh

ls -l

supplement, gwx and openssh directories should be present.

Log Into SCO FTP
Server

3. Log into the SCO FTP server as follows:

(a) Type:

ftp ftp.sco.com

The following appears in the command shell:

Connected to ftp.sco.com.
220 ftp.sco.com ready.
Name (ftp.sco.com:root):

(b) Type anonymous and press ENTER.

The following appears in the command shell:

Password:

(c) Type your email address and press ENTER.

The following appears in the command shell:

230- Welcome to SCO's FTP site!

This site hosts UNIX software patches, device drivers and supplements
from SCO.

To access Skunkware and Supplemental Open Source Packages, please
connect to ftp2.caldera.com.

Our FTP site currently only allows Passive (PASV) FTP connections. If
you are experiencing problems accessing the site please verify that
passive mode is enabled in your FTP client.

230 Anonymous access granted, restrictions apply.
Remote system type is UNIX.
Using binary mode to transfer files.
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Download OS
Supplement

(oss646c) Package

4. Download the OS Supplement (oss646c) package as follows:

(a) Change local directory to /tmp/supplement by typing:

lcd /tmp/supplement

The following appears in the command shell:

Local directory now /tmp/supplement

(b) Change FTP working directory to /pub/openserver5/oss646c by typing:

cd /pub/openserver5/oss646c

The following appears in the command shell:

250 CWD command successful.

(c) Initiate the download by typing:

mget *

The following appears in the command shell:

mget VOL.000.000? y

(d) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
1536 bytes received in 4.2 seconds (0.36 Kbytes/s)
mget VOL.000.001? y

(e) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
82432 bytes received in 0.69 seconds (116.67 Kbytes/s)
mget VOL.000.002? y

(f) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
33280 bytes received in 0.47 seconds (69.15 Kbytes/s)
mget VOL.000.003? y

(g) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
2175488 bytes received in 8.5 seconds (250.53 Kbytes/s)
mget VOL.000.004? y

(h) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
488448 bytes received in 2.2 seconds (217.81 Kbytes/s)
mget VOL.000.005? y
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(i) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
512 bytes received in 0.09 seconds (5.56 Kbytes/s)
mget VOL.000.006? y

(j) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
2802688 bytes received in 11 seconds (253.66 Kbytes/s)
mget VOL.000.007? y

(k) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
16384 bytes received in 0.37 seconds (43.24 Kbytes/s)
mget VOL.000.008? y

(l) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
1320448 bytes received in 6 seconds (216.36 Kbytes/s)
mget VOL.000.009? y

(m)Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
7168 bytes received in 0.28 seconds (25.00 Kbytes/s)
mget VOL.000.010? y

(n) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
356864 bytes received in 1.8 seconds (194.69 Kbytes/s)
mget oss646c.txt? y

(o) Type y and press ENTER.

The following appears in the command shell:

200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
3579 bytes received in 0.16 seconds (21.84 Kbytes/s)
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Download OS
GWX libs (gwxlibs-
2.1.0Ba) Package

5. Download the GWX libs (gwxlibs-2.1.0Ba) package as follows:

(a) Change local directory to /tmp/gwx by typing:

lcd /tmp/gwx

The following appears in the command shell:

Local directory now lcd /tmp/gwx

(b) Change FTP working directory to 
/pub/openserver5/opensrc/gwxlibs-2.1.0Ba by typing:

cd /pub/openserver5/opensrc/gwxlibs-2.1.0Ba

The following appears in the command shell:

250 CWD command successful.

(c) Initiate the download by typing:

get gwxlibs210Ba_vol.tar

The following appears in the command shell:

local: gwxlibs210Ba_vol.tar remote: gwxlibs210Ba_vol.tar
200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
96600576 bytes received in 3.8e+02 seconds (247.74 Kbytes/s)

Download OS
OpenSSH

(openssh-4.2p1)
Package

6. Download the OpenSSH (openssh-4.2p1) package as follows:

(a) Change local directory to lcd /tmp/openssh by typing:

lcd /tmp/openssh

The following appears in the command shell:

Local directory now lcd /tmp/openssh

(b) Change FTP working directory to 
/pub/openserver5/opensrc/openssh-4.2p1 by typing:

cd /pub/openserver5/opensrc/openssh-4.2p1

The following appears in the command shell:

250 CWD command successful.

(c) Initiate the download by typing:

get openssh42p1_vol.tar

The following appears in the command shell:

local: openssh42p1_vol.tar remote: openssh42p1_vol.tar
200 PORT command successful.
150 File status okay; about to open data connection.
226 Transfer complete, closing data connection.
692736 bytes received in 3.9 seconds (174.81 Kbytes/s)

7. Exit the SCO FTP server by typing:

quit

The following appears in the command shell:

221 Service closing control connection.
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8. Use the SCO Software Manager program to install the packages in the 
following order:

• OS Supplement
• GWX libs
• OpenSSH

(a) Type:

scoadmin software

The SCO Software Manager program appears.

(b) Select Software >Install New...

(c) Select media images from the Media device: menu.

(d) Type the full path of the directory that contains the OS Supplement 
(oss646c) package.

(e) Select the OS Supplement (oss646c) package for installation. 
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(f) Select Continue in the next screen.

(g) Repeat steps b thru g to install the remaining two packages (that is, 
gwxlibs-2.1.0Ba and openssh-4.2p1.

9. After all three packages are installed, start the prngd daemon by typing:

/etc/prngd start
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Uninstalling the Avamar SCO Client

NOTE:  This procedure demonstrates how to uninstall Ava-
mar SCO Client software on SCO Open Server 5.0.5 or 5.0.7.
The procedure is substantially the same for uninstalling Ava-
mar SCO Client software on UnixWare 7.1.3. However, the
install package name, specific files removed, and so forth
will be slightly different.

Log in as root 1. Open a command shell and log in as root.

2. Stop the avagent process by typing:

/usr/local/avamar/etc/avagent.d stop

The following appears in the command shell:

avagent.d Info: Stopping AvamarClient Agent (avagent)...
avagent.d Info: Agent not yet terminated (15 seconds), please wait.
avagent.d Info: Agent not yet terminated (30 seconds), please wait.
avagent.d Info: Agent not yet terminated (45 seconds), please wait.
avagent.d Info: Client Agent stopped.

Uninstall Avamar
Software

3. Type the following:

pkgrm avamar

The following appears in the command shell:

The following package is currently installed:
Avamar AvamarClient

(i386) 5.0-100.400

Do you want to remove this package [yes,no,?,quit] 

4. Type yes and press ENTER.

The following appears in the command shell:

## Removing installed package instance <avamar>
## Verifying package dependencies.
## Executing preremove script.
avagent.d Info: Stopping Avamar Client Agent (avagent)...
avagent.d Info: Agent not yet terminated (15 seconds), please wait.
avagent.d Info: Agent not yet terminated (30 seconds), please wait.
avagent.d Info: Agent not yet terminated (45 seconds), please wait.
avagent.d Info: Client Agent stopped.
## Processing package information.
## Removing pathnames in <none> class
/usr/local/avamar/var <non-empty directory not removed>
/usr/local/avamar/lib/libpthread.so.20
/usr/local/avamar/lib
/usr/local/avamar/etc/scripts
/usr/local/avamar/etc/avagent.d
/usr/local/avamar/etc
/usr/local/avamar/bin/unix.pin
/usr/local/avamar/bin/avtar.bin
/usr/local/avamar/bin/avtar
/usr/local/avamar/bin/avregister
/usr/local/avamar/bin/avagent.bin
/usr/local/avamar/bin
## Removing pathnames in <syms> class
## Removing pathnames in <dirs> class
## Removing pathnames in <mans> class
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## Removing pathnames in <libs> class
## Removing pathnames in <etcs> class
## Removing pathnames in <apps> class
## Executing postremove script.
uninstallation successful
## Updating system information.

Removal of <avamar> was successful.

Upgrading the Avamar SCO Client
In order to upgrade your Avamar SCO Client software, you must completely 
uninstall the old software (page 62) and install the new software (page 54). 

Manually Stopping and Restarting the avagent Service
The Avamar SCO Client agent (avagent) is configured to run as a service and is 
started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/avagent stop

Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/avagent restart

Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/avagent status
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This chapter describes how to install and register the Avamar Solaris Client 
software on a client computer.

IMPORTANT:  Uninstall (page 69) any previous version of
Avamar Solaris Client software before installing the new ver-
sion. 

System Requirements
The client computer on which you want to install the Avamar Solaris Client 
software must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • Sun Solaris 10
• Sun Solaris 9
• Sun Solaris 8

CPU • SPARC
• x86 (Solaris 10 only)

Filesystem • UFS
• VxFS
• ZFS

RAM 128 MB.

Hard Drive Space 200 MB permanent hard drive space (1 GB recommended) 
for software installation.
The Avamar client software also requires an additional 12 
MB of permanent hard drive space for each 64 MB of 
physical RAM. This space is used for local cache files. 

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Downloading the Install Package
1. Log into the computer onto which you want to install this software.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

7. Download the Avamar Solaris Client install package to any convenient 
temporary install directory on your system.

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

8. Note the actual filename of the Avamar Solaris Client install package. 

NOTE:  AVAMARSOLARIS.pkg is used as an example file-
name for the Avamar Solaris Client install package in the
remainder of this chapter. Your actual filename will be differ-
ent.
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Customizing the Install Location
This topic is only applicable if you want to install the Avamar Solaris Client 
somewhere other than the default location.

To customize the var and base installation directories, set the following 
environment variables to the desired location before beginning the installation 
procedure:

• AVAMAR_INSTALL_VARDIR_PATH
• AVAMAR_INSTALL_BASEDIR_PATH

Installing and Registering the Avamar Solaris Client
Log in as root 1. Open a command shell and log in as root.

Install Avamar
Solaris Client

Software

2. Change directory to your temporary install directory (page 65). For 
example:

cd /tmp

3. Type the following:

pkgadd -d AVAMARSOLARIS.pkg

Where AVAMARSOLARIS.pkg is the actual filename of the Avamar Solaris 
Client install package you previously downloaded (page 65).

The following appears in the command shell:

The following packages are available:
 1 AVMRclnt Avamar Solaris Client

(sparc) 5.0-100.400

Select package(s) you wish to process (or 'all' to process all packages). 
(default: all) [?,??,q]:

4. Type 1 and press ENTER.

The following appears in the command shell:
Processing package instance...

Avamar Solaris Client
(sparc) 5.0-100.400

This software is copyright EMC 2001-2009.

Please read and agree to the End User License Agreement which will be placed in 
the base directory of the install as a file named AvamarClient-License.txt.

EMC Corporation
135 Technology Drive Suite 100
Irvine, CA 92618
(949) 743-5100

Relocate install from /opt/AVMRclnt? [n]
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  66



 Installing and Registering the Avamar Solaris Client
INSTALLING/UNINSTALLING AVAMAR SOLARIS CLIENT
5. Press ENTER to accept the default install location.

The following appears in the command shell:
Directory to locate cache & log files [/var/avamar]:

Avamar Solaris Client local cache files require an additional 12 MB of 
permanent hard drive space for each 64 MB of physical RAM on this 
machine. 

Ensure that the directory location you specify in this step has sufficient 
room for these local cache files.

6. Press ENTER to accept the default cache and log file location.

The following appears in the command shell:

Using </opt> as the package base directory.
## Processing package information.
## Processing system information.
## Verifying package dependencies.
## Verifying disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/setgid programs.

This package contains scripts which will be executed with super-user permission 
during the process of installing this package.

Do you want to continue with the installation of <AVMRclnt> [y,n,?]

7. Type y and press ENTER.

The following appears in the command shell:

Installing EMC Client as <AVMRclnt>
## Installing part 1 of 1.
/opt/AVMRclnt/AvamarClient-License.txt
/opt/AVMRclnt/bin/avagent.bin
/opt/AVMRclnt/bin/avregister
/opt/AVMRclnt/bin/avrunner
/opt/AVMRclnt/bin/avscc
/opt/AVMRclnt/bin/avtar
/opt/AVMRclnt/bin/avtar.bin
/opt/AVMRclnt/bin/unix.pin
/opt/AVMRclnt/etc/avagent.d
[ verifying class <apps> ]
/opt/AVMRclnt/lib/libstdc++.so.5.0
[ verifying class <libs> ]
## Executing postinstall script.
Installation complete
You may run /opt/AVMRclnt/bin/avregister to register this host with the 
Administrator server.
avagent Info <5241>: Logging to /opt/AVMRclnt/var/avagent.log
avagent Info <5417>: daemonized as process id 9714
avagent.d Info: Server started.
Installation of <AVMRclnt> was successful.
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Register this Client
With the Avamar

Server

8. Type the following:

/opt/AVMRclnt/bin/avregister

The following appears in the command shell:
=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

9. Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:
Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and subdomains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a subdomain (for example,
clients/MyClients), do not include a slash (/) as the first
character. Including a slash as the first character will cause
an error and prevent you from registering this client.

10. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Server stopped.
avagent Info <5241>: Logging to /opt/AVMRclnt/var/avagent.log
avagent.d Info: Client activated successfully.
avagent Info <5241>: Logging to /opt/AVMRclnt/var/avagent.log
avagent Info <5417>: daemonized as process id 10459
avagent.d Info: Server started.
Registration Complete.
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Uninstalling the Avamar Solaris Client
Log in as root 1. Open a command shell and log in as root.

Uninstall Avamar
Software

2. Type the following:

pkgrm AVMRclnt

The following appears in the command shell:

The following package is currently installed:
AVMRclnt Avamar Solaris Client

(sparc) 5.0-100.400
Do you want to remove this package?

3. Type y and press ENTER.

The following appears in the command shell:

## Removing installed package instance <AVMRclnt>

This package contains scripts which will be executed with super-user permission 
during the process of removing this package.

Do you want to continue with the removal of this package [y,n,?,q]

4. Type y and press ENTER.

The following appears in the command shell:

## Verifying package dependencies.
## Processing package information.
## Executing preremove script.
avagent.d Info: Server stopped.
## Removing pathnames in class <syms>
## Removing pathnames in class <dirs>
## Removing pathnames in class <mans>
## Removing pathnames in class <libs>
/opt/AVMRclnt/lib/libstdc++.so.5.0
/opt/AVMRclnt/lib
## Removing pathnames in class <etcs>
## Removing pathnames in class <apps>
/opt/AVMRclnt/etc/avagent.d
/opt/AVMRclnt/etc
/opt/AVMRclnt/bin/unix.pin
/opt/AVMRclnt/bin/avtar.bin
/opt/AVMRclnt/bin/avtar
/opt/AVMRclnt/bin/avscc
/opt/AVMRclnt/bin/avrunner
/opt/AVMRclnt/bin/avregister
/opt/AVMRclnt/bin/avagent.bin
/opt/AVMRclnt/bin
/opt/AVMRclnt/AvamarClient-License.txt
/opt/AVMRclnt
## Removing pathnames in class <none>
## Updating system information.

Removal of <AVMRclnt> was successful.
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Upgrading the Avamar Solaris Client
In order to upgrade your Avamar Solaris Client software on the Sun Solaris 
platform, you must completely uninstall the old software (page 69) and install the 
new software (page 66). 

Manually Stopping and Restarting the avagent Service
The Avamar Solaris Client agent (avagent) is configured to run as a service and is 
started automatically as part of the installation procedure. It will also restart 
automatically following a system reboot. Therefore, in most cases, you do not 
need to manually stop or restart it. However, if you experience unexpected system 
behavior and do not want to reboot your entire system, the following commands 
can be used to manually stop and restart the avagent service.

Manually Stopping the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/init.d/avagent Stop

Manually Restarting the avagent Service

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/init.d/avagent start

Getting avagent Status

Log in as root 1. Open a command shell and log in as root.

2. Type the following:

/etc/init.d/avagent status
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This chapter describes how to install and register Avamar Windows Client software 
on a client computer.

Capabilities and Limitations
This topic discusses current capabilities and limitations of the Avamar Windows 
Client. 

Windows Server 2008 Core Installations. If you deployed Windows Server 
2008 using the Core Installation feature, you will not have access to the traditional 
full graphical user interface (GUI). Therefore, you must install and maintain the 
Avamar Windows Client software entirely from a DOS prompt using the msiexec 
utility. Refer to Windows Server 2008 Core Installation and Maintenance (page 76) 
for additional information.

Disabling NTFS Last Access Time Inhibits Backing Up Changed ACLs. If 
the NTFS Last Access Time feature is disabled on a Windows backup client, the 
Avamar Windows Client software is not able to detect any further Windows ACL 
changes. This means that the ACL setting stored during the original file backup is 
the ACL setting that will be applied on all future restores.

NTFS Last Access Time feature is enabled by default, but is sometimes disabled 
for performance purposes. Reestablishing proper Avamar Windows Client ACL 
backup behavior requires that you:

1. Enable NTFS Last Access Time feature

There are two ways to reenable the NTFS Last Access Time feature.

The registry entry that controls whether Last Access Time is enabled or 
disabled is 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSyste
m\NtfsDisableLastAccessUpdate. 

A value of 1 enables Last Access Time; a value of 0 disables Last Access 
Time.
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On Windows XP, Server 2003 and Vista platforms, you can enable NTFS 
Last Access Time by typing the following command from a command 
prompt:

fsutil behavior set disablelastaccess 0

2. Delete all local Avamar Windows Client cache files

The Avamar Windows Client cache files are:

C:\Program Files\avs\var\f_cache.dat

C:\Program Files\avs\var\p_cache.dat

Delete these files. This will cause them to be recreated the next time this 
client is backed up.

System Requirements
The client computer on which you want to install the Avamar Windows Client 
software must meet the following minimum requirements: 

REQUIREMENT MINIMUM

Operating System • Windows Vista Home basic
• Windows Vista Premium
• Windows Vista Enterprise (32- and 64-bit)
• Microsoft Server 2008
• Microsoft Windows Cluster Server 2003
• Microsoft Server 2003
• Microsoft Server 2003 x64 Edition
• Microsoft Windows XP Professional
• Microsoft Windows XP Home

NOTE:  Microsoft Server 2008 and Microsoft Windows 
Cluster Server 2003 both support active/passive and 
active/active cluster configurations.

Filesystem • FAT16
• FAT32
• NTFS

RAM 512 MB.

Hard Drive Space 250 MB permanent hard drive space (1 GB recommended) 
for software installation.

The Avamar client software also requires an additional 
12 MB of permanent hard drive space for each 64 MB of 
physical RAM. 

Additional disk space might be required by your snapshot 
technology.

Backing up the Windows System State requires an 
additional 1 GB of free disk space.

Network Interface 10baseT or higher, configured with latest drivers for your 
platform.
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Installing the Avamar Windows Client
This procedure should be used to install Avamar Windows Client software on all 
supported versions of Microsoft Windows (page 72) except Server 2008 Core 
Installations.

IMPORTANT:  For Windows clusters, you must install the
Avamar Windows Client on all nodes of the cluster. Also, the
client must be installed to the same directories on all cluster
nodes. For example, if you install the Avamar client to
C:\AVS1 on the first node, you must install the Avamar client
to the same directory C:\AVS1 on all other nodes in the clus-
ter. 
Refer to Appendix A — Support for Microsoft Windows Clus-
ters (page 95) for complete cluster installation instructions. 

IMPORTANT:  Do not use this procedure to install Avamar
Windows Client software on Server 2008 Core Installations.

Refer to Windows Server 2008 Core Installation and Mainte-
nance (page 76) if installing Avamar Windows Client soft-
ware on Windows Server 2008 Core.

1. Log into the computer onto which you want to install this software.

IMPORTANT:  You must log in as Administrator if installing
the Avamar Windows Client on Windows Vista platforms.

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.
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7. Double-click the AvamarClient-windows-x86-VERSION.msi install 
package.

Your browser will prompt you to either open the file “in-place” (on the 
server) or save it to your local computer. Either method will work. However, 
if you save the file to your local computer, you must open (double-click) 
that installation file to continue with this procedure.

8. Open the installation in place (on the server).

The installation wizard appears.

9. Follow the on-screen instructions.

Immediately after accepting the End User Licensing Agreement, the 
Backup for Windows Setup screen appears.

10.Do one of the following: 

11.Click Next.

The Ready to install Backup for Windows screen appears.

12.Click Install to begin the installation procedure.

13.When prompted, click Finish to complete the installation procedure.

The installation wizard closes.

The Avamar icon (shown left) appears in the system tray.

IF DO THIS

You are installing Avamar Windows Client 
software on a server.

Go directly to step 11.

You are installing Avamar Windows Client 
software on a desktop or laptop machine.

Select Desktop/Laptop 
Support, then go to step 11.
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Registering the Avamar Windows Client
Before you can backup or restore any files on this client computer, you must 
register it with the Avamar server.

1. Right click the Avamar system tray icon (shown left).

A menu appears.

2. Select Activate.

The Activate Client Setup dialog box appears.

3. Type the following:

4. Click OK.

The Activate Client Setup dialog box closes.

FIELD DESCRIPTION

Administrator 
Server Address

Administrator server network hostname as defined 
in DNS.

Client Domain Avamar domain where you want this client to reside.
The default domain is “clients.” However, your 
Avamar system administrator may have defined 
other domains and subdomains. Consult your 
Avamar system administrator for the specific domain 
you should use when registering this client.
IMPORTANT:  If typing a subdomain (for example, 
clients/MyClients), do not include a slash (/) as the 
first character. Including a slash as the first 
character will cause an error and prevent you from 
registering this client.
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Uninstalling and Upgrading the Avamar Windows Client
Unlike other platforms, previous versions of Avamar Windows Client software do 
not have to be explicitly uninstalled before a new version can be installed. If you 
attempt to install the Avamar Windows Client on a computer that already has it 
installed, you will be prompted during installation to select one of the following 
choices:

1. Upgrade current Avamar Windows Client installation to the new version.

2. Remove old Avamar Windows Client installation.

If you decide to remove the old installation, you will need to re-run the 
installation file to install the new version (the current installation session 
becomes an “uninstall” session, then terminates).

You can also use the Windows Control Panel Add/Remove Programs feature to 
completely uninstall the Avamar Windows Client.

IMPORTANT:  If you need to upgrade to an older version
Avamar Windows Client software, you must completely unin-
stall the existing version and install the new software.
Upgrades are not possible under these circumstances.

Windows Server 2008 Core Installation and Maintenance
If you deployed Windows Server 2008 using the Core Installation feature, you will 
not have access to the traditional full graphical user interface (GUI). Therefore, 
you must install and maintain the Avamar Windows Client software entirely from a 
DOS prompt using the msiexec utility using these procedures. 

Installing and Registering the Avamar Windows Client

IMPORTANT:  In order to obtain the Avamar Windows Cli-
ent software installation package, you will need another
computer capable of connecting to the Avamar using a web
browser.

1. Log into a computer capable of connecting to the Avamar using a web 
browser (not the Windows Server 2008 Core system).

2. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar server network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 
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3. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

4. Page down until the Documents and Downloads hyperlink is visible.

5. Click Documents and Downloads.

The Documents and Downloads page appears.

6. Click the Windows 2008 hyperlink.

A directory listing appears in your browser.

7. Use WinSCP or FTP to copy the AvamarClient-windows-x86-VERSION.msi 
install package to a temporary folder on the Windows Server 2008 Core 
system.

NOTE:  C:\Temp is used as an example temporary folder for
the remainder of this procedure. Your actual temporary
folder might be different.

8. Log into the Windows Server 2008 Core system and open a DOS prompt.

9. Change directory to the temporary folder by typing:

C:

cd \Temp

10. Initiate the Avamar Windows Client software installation by typing:

msiexec /i AvamarClient-windows-x86-VERSION.msi

The installation wizard appears.

11. Follow the on-screen instructions.

12.Click Finish to complete the installation procedure.

13.Next, you must register this Avamar Windows Client with the Avamar 
server using the avregister.bat program as follows:

(a) Switch to the DOS prompt.

(b) Type:

C:\Program Files\avs\bin\avregister.bat MCS-NAME DOMAIN

Where MCS-NAME is the actual network hostname (as defined in DNS) 
of your Avamar MCS and DOMAIN is an optional location for this client 
on the Avamar server, respectively.

If DOMAIN is not supplied, the default domain “clients” is used. 
However, your Avamar system administrator may have defined other 
domains and subdomains. Consult your Avamar system administrator 
for the specific domain you should use when registering this client.
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IMPORTANT:  If specifying a subdomain (for example, (for
example, clients/MyClients), do not include a slash (/) as the
first character. Including a slash as the first character will
cause an error and prevent you from registering this client.

Uninstalling the Avamar Windows Client

Uininstalling the Avamar Windows Client software is accomplished by running the 
msiexec utility as described in the previous topic. 

If you pass in the same installation package, a wizard screen appears, which 
offers you an opportunity to remove or repair the current Avamar Windows Client 
software.

To unistall the current Avamar Windows Client software, select Remove and 
follow the remaining on-screen instructions.

Upgrading the Avamar Windows Client

Uininstalling the Avamar Windows Client software is accomplished by running the 
msiexec utility as described in the previous topics.

If you pass in a newer version installation package, a wizard screen appears, 
which offers you an opportunity to install the newer version Avamar Windows 
Client software.
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Following installation and registration, Avamar clients typically have their data 
backed up automatically by way of regularly scheduled backups initiated by the 
Avamar server. Data can also be restored by the system administrator using 
Avamar Administrator. However, “on-demand” backup and restore operations can 
also be initiated directly from the Avamar client.

Capabilities and Limitations

International Character Support. Avamar generally supports the use of 
specific supported international characters in directory, folder and filenames. 
However, proper display of international language characters is contingent on the 
client computer installed system fonts being compatible with the original 
language. If you attempt to browse backups that were created with international 
characters and you do not have a compatible font installed on your system, any 
characters that cannot be resolved by the system will be displayed as rectangles. 
This is a normal limitation of that particular situation and does not affect the 
ability to restore these directories, folders or files. Refer to your Avamar Release 
Notes for additional international language support information.

Restoring International Characters With Avamar Web Restore. When 
performing restores using the Avamar Web Restore feature, restores containing 
directories or multiple files are delivered in the form of a zip file. When unzipping 
the zip file, file and directory names containing international characters might not 
restore properly due to inherent limitations in some zip utilities. Therefore, in 
order to correctly restore files containing international characters using the 
Avamar Web Restore feature, you must use a zip utility that fully supports 
international characters. Examples of zip utilities that have been confirmed to 
work properly include: 

• Winrar 3.80 or later
• Winzip 12.0 or later
• 7zip 4.65 or later

Also be advised that Microsoft Windows compressed folders are specifically known 
to not reliably handle international characters and should not be used with the 
Avamar Web Restore feature.
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Restoring Encrypted Files. It is not possible to restore encrypted files with the 
the Avamar Web Restore feature. Any files that were encrypted at the time of the 
original backup will be restored as empty (zero byte) files. If you need to restore 
encrypted files, contact your Avamar system administrator. He or she can restore 
encrypted files using the Avamar Administrator graphical management console. 

Windows Clients
Avamar Windows Clients initiate on-demand backups and restores using the 
Avamar client application running in the system tray. 

Performing an On-Demand Backup

1. Right click the Avamar system tray icon (shown left).

A menu appears.

2. Select Back Up Now.

The Avamar Client On-Demand Backup dialog box appears.

3. Select a set of files from the drop-down list.

4. Select the files and directories you want to backup.

5. Click Start Backup.

The Avamar Client On-Demand Backup dialog box closes and the backup is 
initiated.
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Performing a Restore

On-demand restores are initiated from the Avamar client application running in 
the system tray. However, you actually select which files to restore from your web 
browser.

IMPORTANT:  Due to inherent limitations in the way Win-
dows handles encryption and decryption, encrypted files can-
not be successfully restored using this procedure.

1. Right click the Avamar system tray icon (shown left).

A menu appears.

2. Select Restore.

Your web browser is launched.

A Security Alert dialog box may appear (depending on your specific 
browser settings).

3. If a Security Alert dialog box appears, click Yes to proceed.

The Security Alert dialog box closes and the Avamar Secure Logon web 
page appears.
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4. Type the following:

5. Click Log on.

The Avamar Web Services web page appears.

FIELD DESCRIPTION

Account Type your Avamar user account name in the form of:
USERID@AUTHENTICATION-SYSTEM

Where USERID is your Avamar user name and 
AUTHENTICATION-SYSTEM is the authentication system 
defined for your Avamar user account.
The default internal authentication system is “avamar.”
You may be using an external authentication system (for 
example, Windows Active directory, OpenLDAP, and so 
forth) at your site. Consult your Avamar system 
administrator for additional information.

Client Path Type the location of this Avamar client in the form of:
/DOMAIN/CLIENT

Where DOMAIN is the Avamar domain (not Internet 
domain) where this client resides and CLIENT is the 
Avamar client name.
IMPORTANT:  This entry must begin with a forward 
slash (/).

Password Avamar user account password.
If using the internal “avamar” authentication system, 
Avamar passwords are case-sensitive and must:

• Be between six and 32 characters in length
• Contain only alphanumeric, hyphen, period or 

underscore characters 
• Contain at least one alphabetic character

If using an external authentication system, the password 
rules and constraints of that system apply.
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6. Click Backups.

The Avamar Web Services web page provides a 
browsable calendar for locating backups in the 
Avamar server.

Underlined dates indicate that a backup was 
performed on that date, from which you ca 
restore files.

Clicking a valid backup date on the calendar 
populates the backups list beside the calendar.

Clicking a valid backup name populates the 
backup contents list below the calendar.

7. Click a valid (underlined) backup date in the Calendar.

8. Click a valid (underlined) backup in the Sequence Number column.

9. Click Name to expand the directory tree.

At many levels of the file system, one or more zip files will appear. These 
zip files provide the mechanism for restoring multiple files and directories. 
Simply download them as you would any other file from a web site and 
unzip the zip file, either directly overwriting the file you want to restore or 
unzipping to a temp directory where you can browse the restored files prior 
to moving them into the final location (for example, your My Documents 
folder, Program Files folder, and so forth).
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IMPORTANT:  If more than one file is selected for restore,
the sum of all the original file sizes cannot exceed 1GB. If
your restore requirements exceed this limitation, you must
restore your files in several smaller batches or have your
Avamar system administrator restore your files using Ava-
mar Administrator.

However, there is no size limitation on restoring a single file
in this manner. 

10.Click the file or zip file you want to restore.

11.Download or open the file or zip file by following the on-screen instructions 
provided by your web browser.

TIP:  When working with zip files, it is a good practice to
download and unzip the contents to a temp directory (for
example, C:/temp). This allows you to open and verify
restored files prior to moving them to their final location (for
example, your My Documents folder, Program Files folder,
and so forth). However, you can unzip files directly to their
final location if you decide to do so.

12.Unzip the zip file using an approved zip utility (page 79), then restore the 
desired directories or files.

Getting Status

1. Right click the Avamar system tray icon (shown left).

A menu appears.

2. Select Open.

The Avamar Client Status dialog box appears.

In-progress backups are shown in the Work Orders list.
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Avamar Mac OS X Clients initiate on-demand backups and restores using the 
AvamarClient application, located in the Applications folder. By default, the 
AvamarClient application is launched at login, and appears in the Dock while 
running.

Performing an On-Demand Backup

1. Right click the AvamarClient application icon.

A menu appears.

2. Select Back Up Now.

The Avamar Client On-Demand Backup Dialog box appears.

3. Select the files and directories you want to backup.

4. Click Back Up.

The Avamar Client On-Demand Backup Dialog box closes and the backup is 
initiated.
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Performing a Restore

On-demand restores are initiated from the AvamarClient application running in the 
Dock. However, you actually select which files to restore from your web browser.

1. Right click the AvamarClient application icon.

A menu appears.

2. Select Restore.

Your web browser is launched.
A Security Alert dialog box may appear (depending on your specific 
browser settings).

3. If a Security Alert dialog box appears, click Yes to proceed.

The Security Alert dialog box closes and the Avamar Secure Logon web 
page appears.
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4. Type the following:

5. Click Log on.

The Avamar Web Services web page appears.

FIELD DESCRIPTION

Account Type your Avamar user account name in the form of:
USERID@AUTHENTICATION-SYSTEM

Where USERID is your Avamar user name and 
AUTHENTICATION-SYSTEM is the authentication system 
defined for your Avamar user account.
The default internal authentication system is “avamar.”
You may be using an external authentication system (for 
example, Windows Active directory, OpenLDAP, and so 
forth) at your site. Consult your Avamar system 
administrator for additional information.

Client Path Type the location of this Avamar client in the form of:
/DOMAIN/CLIENT

Where DOMAIN is the Avamar domain (not Internet 
domain) where this client resides and CLIENT is the 
Avamar client name.
IMPORTANT:  This entry must begin with a forward 
slash (/).

Password Avamar user account password.
If using the internal “avamar” authentication system, 
Avamar passwords are case-sensitive and must:

• Be between six and 32 characters in length
• Contain only alphanumeric, hyphen, period or 

underscore characters 
• Contain at least one alphabetic character

If using an external authentication system, the password 
rules and constraints of that system apply.
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6. Click Backups.

The Avamar Web Services web page provides a 
browsable calendar for locating backups in the 
Avamar server.

Underlined dates indicate that a backup was 
performed on that date, from which you can 
restore files.

Clicking a valid backup date on the calendar 
populates the backups list beside the calendar.

Clicking a valid backup name populates the 
backup contents list below the calendar.

7. Click a valid (underlined) backup date in the Calendar.

8. Click a valid (underlined) backup in the Sequence Number column.

9. Click Name to expand the directory tree.

At many levels of the file system, one or more zip files will appear. These 
zip files provide the mechanism for restoring multiple files and directories. 
Simply download them as you would any other file from a web site and 
unzip the zip file, either directly overwriting the file you want to restore or 
unzipping to a temp directory where you can browse the restored files prior 
to moving them into the final location (for example, your My Documents 
folder, Program Files folder, and so forth).
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IMPORTANT:  If more than one file is selected for restore
the sum of all the original file sizes cannot exceed 1GB. If
your restore requirements exceed this limitation, you must
restore your files in several smaller batches or have your
Avamar system administrator restore your files using Ava-
mar Administrator.

However, there is no size limitation on restoring a single file
in this manner. 

10.Click the file or zip file you want to restore.

11.Download or open the file or zip file by following the on-screen instructions 
provided by your web browser.

TIP:  When working with zip files, it is a good practice to
download and unzip the contents to a temp directory (for
example, /temp). This allows you to open and verify
restored files prior to moving them to their final location (for
example, your Documents folder, Applications folder, and so
forth). However, you can unzip files directly to their final
location if you decide to do so.

12.Unzip the zip file using an approved zip utility (page 79), then restore the 
desired directories or files.

Getting Status

1. Right click the AvamarClient application icon.

Avamar Client commands appear in the menu bar.

2. Select View > Work Order Status from the menu bar.

The Work Order List window appears.

In-progress and completed backups are shown in the Work Orders list.
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AIX, FreeBSD, HP-UX, Linux, SCO and Solaris Clients
AIX, FreeBSD, HP-UX, Linux and Solaris clients initiate on-demand backups and 
restores using the avtar command line.

IMPORTANT:  Space limitations in this publication cause
these examples to continue (wrap) to more than one line,
However, all commands and options must be entered on a
single command line (no line feeds or returns allowed). 

Performing an On-Demand Backup

This example backs up files within the MyFiles and abcd directories on a Linux 
computer and labels the backup jdoeFiles.

1. Open a command shell.

2. Type the following on a single command line:

/usr/local/avamar/bin/avtar -c --label="jdoeFiles"
 MyFiles/ abcd/ --id=jdoe@avamar/clients/MyClient

Performing a Restore

This example restores all of the files found in the backup labeled newsletters that 
were created before the indicated date and time into the old_newsletters directory 
on an HP-UX or Solaris computer. 

1. Open a command shell. 

2. Type the following on a single command line:

/opt/AVMRclnt/bin/avtar -xv --target="old_newsletters"
 --before="2009-10-31 15:00:00"
 --id=jdoe@avamar/clients/MyClient --label="newsletters"

This example restores files found in the abcd and MyFiles directories in the backup 
labeled newsletters into the old_newsletters directory on a Linux computer.

1. Open a command shell. 

2. Type the following on a single command line:

/usr/local/avamar/bin/avtar -xv --label="newsletters"
 --target="old_newsletters" abcd/ MyFiles/
 --id=jdoe@avamar/clients/MyClient
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Getting Status

This example lists information about the three most recent backups created after 
the indicated date and time. Verbose (status and warning) messages are turned 
on and the command path is correct for a Linux client.

1. Open a command shell. 

2. Type the following on a single command line:

/usr/local/avamar/bin/avtar --backups --verbose --count=3
 --after="2009-10-31 11:17:33"--id=jdoe@avamar/clients/MyClient

This example lists files and directories inside the backup labeled jdoeFiles created 
before the indicated date and time. Highly verbose (--verbose=2) messages are 
turned on and the command path is correct for an HP-UX or Solaris computer. 

1. Open a command shell. 

2. Type the following on a single command line:

/opt/AVMRclnt/bin/avtar -t --verbose=2 /myfiles/rem
 --label="jdoeFiles" --before="2009-10-31 04:30:15"
 --id=jdoe@avamar/clients/MyClient
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NetWare Clients
Avamar NetWare Clients initiate on-demand backups and restores from the 
NetWare system console using the avtar command line.

Certain Hidden NetWare Folders and Files Not Backed Up. Due to an 
inherent limitation within Novell Storage Services (NSS), the following folders 
(directories) and files are excluded from all backups:

Two hidden folders (directories): Network Trash Folder and DESKTOP.AFP. 
These folders (directories) will only be present if AppleTalk Filing Protocol (AFP) 
is loaded on the server.

A hidden file, ~dfsinfo.8-p, might be present on NSS volumes. This file is 
created in conjunction with Volume Location Database (VLDB) and Distributed 
File Services (DFS).

This limitation applies to both the (native) Avamar NetWare Client and 
integrations using the Avamar NDMP Accelerator.

Because this limitation is within NSS and not the Avamar client, no interim 
solution exists.

IMPORTANT:  Space limitations in this publication cause
these examples to continue (wrap) to more than one line,
However, all commands and options must be entered on a
single command line (no line feeds or returns allowed). 

Performing an On-Demand Backup

The following example backs up files within the MyFiles directory on a NetWare 
server and labels the backup as “MyFiles.”

From the NetWare server console, type the following on a single command line:

sys:avamar\bin\avtar -c vol1:\MyFiles --server=MyMCServer
 --account=/clients/MyClient --sms_auth=.admin.MyContext
 --sms_password=MyEDirPwd --id=MyAvUser --password=MyAvPassword
 --label="MyFiles"

Notice the syntax used to specify the volume prefix of the path. The backup will be 
successful if either “vol1:” or “vol1:\” is entered. However, you must specify the 
same volume prefix during your on-demand restore (page 93) or the restore will 
fail. If unsure, perform a status request (page 93) to verify the syntax used for 
the original backup.

IMPORTANT:  NSS volumes with compression enabled can
cause memory contention issues during backups. Therefore,
EMC strongly recommends that compression be suspended
during backup operations.
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Performing a Restore

The following example restores all the contents of vol1:\MyDir from the backup 
labeled MyFiles into the NewFiles directory on a NetWare server, and logs all 
messages to MyRestore1.log.

From the NetWare server console, type the following on a single command line:

sys:avamar\bin\avtar -xv --label="MyFiles" --target="vol1:\NewFiles"
 vol1:\MyDir --server=MyMCServer --account=/clients/MyClient
 --sms_auth=.admin.MyContext --sms_password=MyEDirPwd --id=MyAvUser
 --password=MyAvPassword --logfile=sys:\avamar\var\MyRestore1.log

The following example restores vol1:\MyDir from the backup labeled MyFiles to its 
original location on a NetWare server. All messages are logged to MyRestore2.log.

From the NetWare server console, type the following on a single command line:

sys:avamar\bin\avtar -xv --label="MyFiles" vol1:\MyDir
 --server=MyMCServer --account=/clients/MyClient
 --sms_auth=.admin.MyContext --sms_password=MyEDirPwd --id=MyAvUser
 --password=MyAvPassword --logfile=sys:\avamar\var\MyRestore2.log

Getting Status

The following example lists information about the three most recent backups 
created after the indicated date and time. Verbose (status and warning) messages 
are turned on and the command path is correct for a NetWare client.

From the NetWare server console, type the following on a single command line:

sys:avamar\bin\avtar --verbose --backups --count=3
 --after="2009-10-31 11:17:33" --server=MyMCServer
 --account=/clients/MyClient --sms_auth=.admin.MyContext
 --sms_password=MyEDirPwd --id=MyAvUser --password=MyAvPassword

The following example lists files and directories inside the backup labeled MyFiles 
created before the indicated data and time. Highly verbose (--verbose=2) 
messages are turned on and the command path is correct for NetWare client.

From the NetWare server console, type the following on a single command line:

sys:avamar\bin\avtar --verbose=2 -t --label="MyFiles"
 --before="2009-10-31 11:17:33" --server=MyMCServer
 --account=/clients/MyClient --sms_auth=.admin.MyContext
 --sms_password=MyEDirPwd --id=MyAvUser --password=MyAvPassword
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Setting Up Pre- or Post-Backup Scripts

This topic provides instructions for setting up pre- or post-backup scripts for an 
Avamar NetWare Client backup.

To set up a pre- or post-backup script, perform the following:

1. Navigate to SYS:AVAMAR\ETC\SCRIPTS.

This location contains your NetWare scripts. For more information about 
creating NetWare scripts, refer to Novell NetWare documentation.

2. Create the Avamar server script.

Avamar server scripts use .SH extensions (PRE.SH, for example).

3. Add a line to PRE.SH that specifies the location of the NetWare script. For 
example, if PRE.NCF script is your pre-backup script you would type the 
following text:

SYS:AVAMAR\ETC\SCRIPTS\PRE.NCF

To specify a pre- or post-script with a backup, use the --run-at-start=SCRIPT or 
--run-at-end=SCRIPT option with the avtar command.

To use Avamar Administrator to back up an Avamar NetWare Client, specify the 
pre- or post-backup scripts in the Backup Command Line Options dialog box:

1. From the Backup Command Line Options dialog box, click Show 
Advanced Options.

2. To run a pre-backup script, type the Avamar server script in the Run user-
defined script at beginning of backup text box.

3. To run a post-backup script, type the Avamar server script in the Run user-
defined script at end of backup text box.

For more information on using Avamar Administrator, refer to the Avamar System 
Administration Guide.
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APPENDIX A — SUPPORT FOR MICROSOFT WINDOWS 
CLUSTERS

This appendix presents additional information about how to protect Microsoft 
Windows clusters environments.

If your site has implemented Microsoft Windows clusters, you must install a 
special Avamar Windows Cluster Client in order to protect data residing on shared 
external storage within those clusters.

For clarity, consider a greatly simplified Microsoft Windows cluster comprising two 
servers (SERVER-A and SERVER-B) and some amount of shared external storage. 
Further consider that this cluster hosts an SQL Server database.

Cluster Groups and Resources. For purposes of this discussion, a cluster 
group (CLUSTER-1) is defined with cluster nodes SERVER-A and SERVER-B, the 
SQL Server database instance and a designated area of the shared external 
storage (for example, drive S:) declared as resources. 

Online and Offline Cluster Groups. SERVER-A is activated as the owner of 
CLUSTER-1. Users now transparently access that SQL Server database instance 
which is running on SERVER-A by way of a virtual IP address and hostname 
assigned to the cluster group. Data is written to and read from the designated 
area of the shared external storage (for example, drive S:). SERVER-B is not the 
owner at this time and cannot access drive S: at all. 
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In a virtual cluster group, at any given time only one server in each cluster can 
access the shared external storage for a single shared application; that server is 
called the active node. The other server will be offline or standing by; that server 
is sometimes referred to as the passive node. In normal day-to-day operations, 
the active and passive roles are frequently rotated between the servers. 

Required Resources. In order to properly protect data residing on this 
Microsoft cluster, the following resources must be defined for it:

• IP address 
• Network name
• Shared external storage

The Quorum disk must be in the default cluster group.

Refer to your Microsoft cluster documentation for additional detailed technical 
information.

Functional Overview. In order to properly protect data residing on this 
Microsoft cluster, you must:

1. Install the normal (non-cluster) Avamar Windows Client on all nodes in the 
cluster (SERVER-A and SERVER-B in the example) according to the 
instructions found in Installing the Avamar Windows Client (page 73).

NOTE:  The Avamar Windows Client must be installed to the
same directories on all cluster nodes. For example, if you
install the Avamar client to C:\AVS1 on the first node
SERVER-A, you must install the Avamar client to the same
directory C:\AVS1 on SERVER-B and all other nodes in the
cluster.

2. Register the Avamar Windows Clients on each machine according to the 
instructions found in Registering the Avamar Windows Client (page 75).

This protects data residing on the internal hard disk drives of both SERVER-
A and SERVER-B. 

NOTE:  Each node (SERVER-A and SERVER-B in the exam-
ple) will be managed as individual clients in Avamar Admin-
istrator and that this will allow you to schedule backups of
data residing on each server’s internal hard disk drive.

3. Install the Avamar Windows Cluster Client on the active node (the server 
that currently has access to the shared external storage) according to the 
instructions found in Installing the Avamar Windows Cluster Client (page 
99).

NOTE:  The Avamar Cluster Client only needs to be installed
on the active node of the cluster. 
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Capabilities, Limitations and Best Practices
Avamar supports the following server platforms and applications in both active-
passive and active-active configurations.

32-bit clusters on Windows Server 2003:

• 32-bit SQL Server 2005 and 2008
• 32-bit Exchange 2003
• 32-bit Lotus Domino 6.5, 7.0, and 8.0x

64-bit clusters on Windows Server 2003:

• 64-bit SQL Server 2005 and 2008
• 64-bit Exchange 2007

32-bit clusters on Windows Server 2008:

• 32-bit SQL Server 2008
• 32-bit Oracle 11g

64-bit clusters on Windows Server 2008:

• 64-bit SQL Server 2008
• 64-bit Exchange 2007
• 64-bit Oracle 11g

NOTE:  Exchange 2003 is only available as a 32-bit applica-
tion and is therefore not supported on 64-bit server plat-
forms.

Do Not Mix Individual Client File system Data with Shared Cluster Data in
the Same Dataset. If you access one of the cluster clients in Avamar 

Administrator, it will be possible to view shared external storage belonging to the 
cluster. However, you should not under any circumstances allow that data to be 
backed up with that client. In fact, you should explicitly exclude any shared cluster 
directories from the Avamar dataset that will be used to back up the individual 
client internal hard disk drive.

Conversely, if you access the cluster client in Avamar Administrator, it will be 
possible to view the internal file system of each client. However, you should not 
under any circumstances allow that data to be backed up as part of shared cluster 
data. In fact, you should explicitly exclude any internal client directories from the 
Avamar dataset that will be used to back up the cluster shared external storage. 

Mixing individual client filesystem data with shared cluster data might compromise 
the ability to properly restore shared cluster data in the future.

Microsoft “Windows Compute Clusters” Not Supported. Microsoft now offers 
two different products with the word “cluster” in the name:

Windows Clustering is the term applied to the cluster product supported by the 
cluster-enabled Avamar Windows Client software. Microsoft also refers to this 
product as a “server cluster.”

Another Microsoft product called a “Windows Compute Cluster” is a relatively 
recent offering and is not supported by the cluster-enabled Avamar Windows 
Client software.
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Do Not Back up the Quorum Drive. Microsoft explicitly advises that no 
attempts should ever be made to back up or restore the Quorum drive. This 
cluster resource must always remain under exclusive control of the cluster. 
Therefore, examine any Avamar datasets to ensure that the resource is not being 
backed up. Explicitly excluding the Quorum drive is the surest way to accomplish 
that.

IMPORTANT:  Drive Q is commonly mapped to the Quorum
drive in many Microsoft Windows cluster environments. If
this is the case in your environment, do not under any cir-
cumstances install any Avamar software on drive Q. Also
ensure that drive Q is excluded from any backup dataset.

Activate physical nodes of cluster on Avamar server before configuring
the Avamar Cluster Client. When configuring a Window cluster with the 

Avamar Cluster Configuration tool, all physical nodes of the cluster must be 
activated on the Avamar server before running the tool. 
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Installing the Avamar Windows Cluster Client
The Avamar Windows Cluster Client only needs to be installed on the active node 
of the cluster. 

IMPORTANT:  For Windows clusters, you must install the
Avamar Windows Client on all nodes of the cluster. Also, they
must be installed to the same directories on all cluster
nodes. For example, if you install the Avamar client to
C:\AVS1 on the first node, you must install the Avamar client
to the same directory C:\AVS1 on all other nodes in the clus-
ter. 

1. Install the Avamar Windows Client on all nodes in the cluster according to 
the instructions found in Installing the Avamar Windows Client (page 73).

2. Register each Avamar Windows Client according to the instructions found 
in Registering the Avamar Windows Client (page 75).

3. Determine which server in the cluster currently has access to the shared 
external storage for that cluster.

This is the active node for that cluster.

4. Log onto the active node in the Windows cluster.

5. From the avs\bin directory, run AvamarClusterConfiguration.exe.

The Setup - Cluster Backup Agent for Windows dialog box appears. 
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6. Select or type the following:

FIELD/OPTION DESCRIPTION

Choose a Group for 
Install or Update.

Select the correct cluster group, on which 
you want to install this software, from this 
drop-down list.

G
R

O
U

P
 R

E
S

O
U

R
C

E
S

Network name for 
backup agent 
communication

This drop-down list contains all network 
names (hostnames) assigned to this 
cluster group.
Select the network name you want to use 
for Avamar client-server communication 
from this drop-down list.

Shared volume for 
backup agent 
configuration and log 
files

This drop-down list contains all shared 
external storage drives assigned to this 
cluster group.
Select the shared external storage drive on 
which you want to install this software.
NOTE:  Some types of Windows clusters, 
such as Exchange Server 2007 CCR 
clusters, typically do not have shared 
storage in the cluster group. In that case, 
the configuration and log files must be 
placed on a shared network folder that all 
nodes in the cluster can access and write 
to. You can specify the path to this folder 
in the Var folder box.

Var folder Specifies the path to a shared network 
folder where the configuration and log files 
are to be placed. If a shared volume is 
available, this field is automatically filled in 
by default.
Type the UNC path or click Browse to 
specify an existing folder, or click Share 
Dir to create a shared folder. 
IMPORTANT:  All nodes of the cluster 
must have write access to the Var folder 
location.
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R
E

G
IS

T
R

A
T

IO
N

Do not register client 
now 

If selected, client associated with this 
cluster group will not be registered with the 
Avamar server. This client will have to be 
manually registered and activated before 
you can back up any data.

Administrator server 
host name or IP 
address

Administrator server network hostname as 
defined in DNS.

Administrator server 
listen data port

The default data port for Avamar client-
server communication is 28001.
Unless you are using a different data port 
at your site, you should leave this set to 
28001.
Consult your Avamar system administrator 
for the specific data port you should use 
when registering this client.

Backup domain for 
this client

Avamar domain where you want this client 
to reside.
The default domain is “clients.” However, 
your Avamar system administrator might 
have defined other domains and sub-
domains. 
Consult your Avamar system administrator 
for the specific domain you should use 
when registering this client.
IMPORTANT:  If typing a sub-domain 
(for example, clients/MyClients), do not 
include a slash (/) as the first character. 
Including a slash as the first character will 
cause an error and prevent you from 
registering this client.

Override automatic 
backup client name 
with this name

If you do not want the Avamar client name 
to be the same as the cluster group name, 
type another Avamar client name in this 
field.

FIELD/OPTION DESCRIPTION
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  101



 Installing the Avamar Windows Cluster Client
APPENDIX A — SUPPORT FOR MICROSOFT WINDOWS CLUSTERS
7. Click Configure.

You will be prompted for credentials to run the Avamar service.

When installation is complete, a message box will confirm the configuration 
of the client is complete, and will list the plug-ins that were configured. 
After you click OK, the setup dialog box is displayed, and the Configure 
button will be unavailable. 

IMPORTANT:  If the Var folder is on a network share, you
must start the backup cluster agent from an account that
has full access permissions to the folder where Avamar log
files are written.

P
LU

G
-I

N
S

Install following plug-
ins

Displays all of the plug-ins currently 
installed that will work on clusters. 
Generally you will not need to change the 
defaults. 
If you don’t want Avamar to use a 
particular plug-in, select the item and then 
click Remove. 
If you want to reload the complete list of 
plug-ins that were displayed when you 
opened this window, click Set All. 

C
LU

S
T

E
R

 N
O

D
E

S

Perform installation on 
following nodes

Displays a list from Windows cluster 
services of all of the nodes that are part of 
the cluster. Generally you will not need to 
change the defaults. 
If there is a node on the cluster that you 
don’t want the cluster backup agent service 
installed on, select the item and then click 
Remove. 
If you want to reload the complete list of 
nodes that are part of this cluster, click Set 
All.

FIELD/OPTION DESCRIPTION
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Uninstalling the Avamar Windows Cluster Client
Uninstalling the Avamar Windows Cluster Client, like installing the Avamar 
Windows Cluster Client, is performed on the active node in the cluster. You do not 
perform the uninstall steps on every node in the cluster. 

NOTE:  It is recommended that all cluster nodes are opera-
tional during the uninstall process. 

1. Log on to the active node in the Windows cluster. 

2. From the avs\bin directory, run AvamarClusterConfiguration.exe.

The Setup - Cluster Backup Agent for Windows dialog box appears. 

3. In Choose a Group for Install or Update, select the cluster group you 
want to uninstall.

4. Click Reset. 

Uninstalling an older version of Windows Cluster Client 
and upgrading to Avamar Cluster Client

To uninstall an older version of cluster client:

1. Take the cluster offline with the cluster administration tool that 
corresponds with the version of Windows Server:

(a) In Windows Server 2008, open Failover Cluster Management. 

-or-
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In Windows Server 2003 open Administrator Tools > Cluster 
Administrator.

(b) Right-click the Backup Agent service and take it offline.

2. On the passive node, in Add/Remove Programs, uninstall all Avamar 
clients: Windows Client and Windows Cluster Client. 

3. On the active node, in Add/Remove Programs, uninstall all Avamar clients: 
Windows Client and Windows Cluster Client. 

4. Using the cluster administration tool again, delete the Backup Agent 
resource. 

Uninstall of all Avamar clients on the passive and active nodes is complete.

To upgrade to Avamar Cluster Client:

NOTE:  When installing the clients, use the same var folder
as the previous Avamar installation. Uninstall does not
remove this folder, so your config and log files will still be
available there. 

1.  Install the Windows Client on each node, following the steps in Installing 
the Avamar Windows Client (page 73) and Registering the Avamar 
Windows Client (page 75)

2. Install the Avamar Cluster Client on the active node, following the steps in 
Installing the Avamar Windows Cluster Client (page 99).

Advanced Information for Multi-Homed Clusters
Plug-ins connect to their corresponding services using the IP address to which the 
plug-in is bound. If the service is not configured to listen on that IP address, the 
plug-in will not be able to connect.

For example, on a multi-homed cluster, if the Avamar backup agent is bound to 
one IP, and Exchange or SQL is bound to a different IP, many key Avamar features 
such as browsing, backup and restore will not work.

Therefore, in order to properly configure multi-homed cluster environments for 
use with Avamar, you must modify the primary network name such that it 
depends on both IP addressees. 
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This appendix describes how to install and register the Avamar Solaris Cluster 
Client software in a Solaris two-node cluster that runs Veritas Cluster Server 
(VCS).

Cluster Configurations Avamar supports backups and restores of the Veritas 
File System (VxFS) from Solaris platforms that run VCS. Avamar supports two-
node active/active and two-node active/passive VCS configurations. 

In an active/active cluster configuration, each node runs an instance of 
Avamar Solaris Cluster Client as an application in separate service groups. This 
functionality provides application redundancy. When a failure occurs on one 
active node, the other active node hosts both service groups.

In an active/passive cluster configuration, the service group is online on the 
active node until a failover occurs. Then the service group comes online in the 
passive node.

You can run backups and restores from both nodes.

System Requirements The Avamar Solaris Cluster Client supports VCS 
versions 4.1 and 5.0 on Solaris 8 and Solaris 10 platforms. The following matrix 
shows the supported versions of VCS and Solaris:

Before installing the Avamar Solaris Cluster Client software, ensure that the 
following requirements have been met:

1. The following software has been installed on each cluster node:

• Veritas Cluster Server
• Veritas Volume Manager (VxVM)
• Veritas File System (VxFS)

VCS
SOLARIS 8

SPARC
SOLARIS 10
X86 64-BIT

SOLARIS 10
SPARC 64-BIT

4.1 X X

5.0 X
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2. The following resources have been configured for VCS service groups: 

• IP resource (which identifies the service group)
• Mount resource (mount point of the shared disk where the Avamar /var 

directory resides)

3. The Avamar server can resolve the service group name through DNS.

Downloading the Avamar Solaris Cluster Client Packages 
User=root 1. Log into the active VCS node.

2. Open a command shell and log in as root.

3. Point your web browser at the Avamar server by typing the following URL:

http://AVAMARSERVER

Where AVAMARSERVER is your actual Avamar system network hostname 
(as defined in DNS) or IP address.

You will be automatically redirected to the Avamar secure web server.

Depending on your browser security settings, a security alert dialog box 
might appear. 

4. If a security alert dialog box appears, click Yes or OK to allow redirection 
to the Avamar secure web server. 

The Secure Log On page appears.

5. Page down until the Documents and Downloads hyperlink is visible.

6. Click Documents and Downloads.

The Downloads and Documentation page appears.

7. Click the correct operating system hyperlink for your client computer.

A directory listing appears in your browser.

Download
Software

Packages

8. Download the Avamar Solaris Cluster Client install packages to any 
convenient temporary install directory on your system.

NOTE:  The remaining steps use the /tmp directory as an
example temporary install directory.

The following table lists the installation packages for each supported 
platform:

FOR THIS PLATFORM DOWNLOAD THIS PACKAGE

Solaris 8 Sparc AvamarClusterClient-solaris8-sparc-
VERSION.pkg

Solaris 10 Sparc AvamarClusterClient-solaris10-sparc-
VERSION.pkg
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Installing and Registering the Avamar Solaris Cluster 
Client

Install the Avamar Solaris Cluster Client software on both nodes in the VCS 
cluster. Start the installation from the active node.

NOTE:  The output in this procedure refers to AvamarClus-
terClient-solaris10-sparc-5.0.100-199.pkg for illustration 
purposes only. 

1. Log into the active VCS node as user root.

Install the Avamar
Solaris Cluster

Client

2. Change directory to your temporary install directory (page 106). For 
example:

cd /tmp

3. Type:

pkgadd -d AVAMARSOLARISCLUSTERCLIENT.pkg

Where AVAMARSOLARISCLUSTERCLIENT.pkg is the installation package 
you previously downloaded (page 106).

The following appears in the command shell:

The following packages are available:
1 AVMRclusclnt Avamar Cluster Client

(sparc) 5.0.100-199

Select package(s) you wish to process (or 'all' to process all packages). 
(default: all) [?,??,q]:

4. Type 1 and press ENTER.

The following appears in the command shell:

Processing package instance <AVMRclusclnt> from </home/source/fresh/installers/
solpkgs/PKGS/AvamarClusterClient-solaris10-sparc-5.0.100-199.pkg>

Avamar Cluster Client(sparc) 5.0.100-199

This software is copyright EMC Corporation, 2001-2009.

Please read and agree to the End User License Agreement which
will be placed in the base directory of the install as a file
named AvamarClient-License.txt.

Solaris 10 x86 64-bit AvamarClusterClient-solaris10-x86_64-
VERSION.pkg

FOR THIS PLATFORM DOWNLOAD THIS PACKAGE
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5. Press ENTER to accept the default install location.

The following appears in the command shell:

## Executing checkinstall script.
Using </opt> as the package base directory.
## Processing package information.
## Processing system information.
## Verifying package dependencies.
## Verifying disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/setgid programs.

This package contains scripts which will be executed with super-user
permission during the process of installing this package.

Do you want to continue with the installation of <AVMRclusclnt> [y,n,?] y

6. Type y and press ENTER.

The following appears in the command shell:

Installing Avamar Cluster Client as <AVMRclusclnt>

## Executing preinstall script.
## Installing part 1 of 1.
/opt/AVMRclusclnt/AvamarClient-License.txt
/opt/AVMRclusclnt/bin/avagent.bin
/opt/AVMRclusclnt/bin/avclusinstall
/opt/AVMRclusclnt/bin/avclusuninstall
/opt/AVMRclusclnt/bin/avoracle
/opt/AVMRclusclnt/bin/avregister
/opt/AVMRclusclnt/bin/avscc
/opt/AVMRclusclnt/bin/avtar
/opt/AVMRclusclnt/bin/avtar.bin
/opt/AVMRclusclnt/bin/oracle.pin
/opt/AVMRclusclnt/bin/sbtscan
/opt/AVMRclusclnt/bin/unix.pin
/opt/AVMRclusclnt/etc/AvamarClient-UpdateReplace.sh
/opt/AVMRclusclnt/etc/avagent.d
/opt/AVMRclusclnt/etc/start.sh
/opt/AVMRclusclnt/etc/stop.sh
[ verifying class <apps> ]
/opt/AVMRclusclnt/lib/libgcc_s.so.1
/opt/AVMRclusclnt/lib/libobk_avamar.so
/opt/AVMRclusclnt/lib/libobk_avamar64.so
/opt/AVMRclusclnt/lib/libstdc++.so.5
[ verifying class <libs> ]
## Executing postinstall script.
Installation complete
You may run /opt/AVMRclusclnt/bin/avclusinstall to configure avamar cluster 
client.

Installation of <AVMRclusclnt> was successful.

7. Run avclustinstall by typing:

cd /opt/AVMRclusclnt/bin/

./avclusinstall

The following appears in the command shell:

Setting PATH set for Veritas Cluster Server commands

Available service groups for configuration

1. oraclegrp

Select an option:
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8. Type 1 and press ENTER.

The following appears in the command shell:

Selected service group: oraclegrp 

Group State
oraclegrp PARTIAL

Enter the resource name of Avamar application for selected service group 
(Default: avagent_oraclegrp): 

9. Type the resource name of the Avamar application and press ENTER.

The following appears in the command shell:

Available mount Resources:

1. oramnt (Mount point: /fsclus01)

Selected mount resource: oramnt 
Do you want to install Avamar Client Plugin for Oracle RMAN? (y/n) [y]:

10.Do one of the following:

The following appears in the command shell:

Enter the hostname or dns alias associated with virtual-ip (10.31.140.36):

11.Type the hostname or DNS alias and press ENTER.

Active node detected

=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.

Using /opt/AVMRclusclnt/cluster/oraclegrp/var as the var dir for the group 
oraclegrp avagent

Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

12.Type the hostname (defined in DNS) or IP address for the Administrator 
server and press ENTER.

The following appears in the command shell:

Enter the Avamar server domain [clients]:

13.Type the domain name and press ENTER.

The following appears in the command shell:

avagent.d Info: Client Agent not running.
avagent Info <5241>: Logging to /opt/AVMRclusclnt/cluster/oraclegrp/var/
avagent.log
avagent Info <5174>: - Reading /opt/AVMRclusclnt/cluster/oraclegrp/var/
avagent.cmd
avagent.d Info: Client activated successfully.
avagent Info <5241>: Logging to /opt/AVMRclusclnt/cluster/oraclegrp/var/
avagent.log
avagent Info <5174>: - Reading /opt/AVMRclusclnt/cluster/oraclegrp/var/
avagent.cmd
avagent Info <5417>: daemonized as process id 7154
avagent.d Info: Client Agent started.
avagent.d Info: Stopping Avamar Client Agent (avagent)...

IF THEN

Oracle will be installed Type y and press ENTER.

Oracle will not be installed Type n and press ENTER.
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avagent.d Info: Client Agent stopped.
Registration Complete.

Avamar Client has been installed for service group 'oraclegrp' successfully.

Do you want to install Avamar in another service group? (y/n) [n]: 

14.Type n and press ENTER.

15. Log into the passive node as root.

16. Type:

cd /opt/AVMRclusclnt/bin

./avclusinstall

The following appears in the command shell:

Setting PATH set for Veritas Cluster Server commands

Available service groups for configuration

1. oraclegrp

Select an option:

17.Type 1 and press ENTER.

The following appears in the command shell:

Selected service group: oraclegrp 

Group State    
oraclegrp OFFLINE    

Do you want to install Avamar Client Plugin for Oracle RMAN? (y/n) [y]:

18.Type y and press ENTER.

Passive node detected.

Avamar Client has been installed for service group 'oraclegrp' successfully.

Do you want to install Avamar in another service group? (y/n) [n]:

19.Type n and press ENTER.

Bringing VCS Resource Online
To bring VCS resources online, type:

hares -online avagent_SERVICEGROUP -sys HOSTNAME

Where SERVICEGROUP is the resource name of the Avamar application specified 
during the installation (page 109) and HOSTNAME is the system where the VCS 
service group is in PARTIAL state.
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Uninstalling the Avamar Solaris Cluster Client
1. Open a command shell and log into the active VCS node as root.

2. Remove the Avamar agent from the VCS service groups by typing:

cd /opt/AVMRclusclnt/bin

./avclusuninstall

The following appears in the command shell:

1. oraclus
Select an option: 1
Selected service group: oraclus

Avamar will be uninstalled for the selected service group. 
Do you want to continue? (y/n) [n]:

3. Type y and press ENTER.

Current backup or restore activity will be stopped on active node for this 
group. 
Do you want to continue? (y/n) [n]: 

4. Type y and press ENTER.

Removing Agent from oraclus  service group... 
Agent resource deleted from group oraclus ... 
Removing the binaries now... 
Do you want to uninstall Avamar in another service group? (y/n) [n]:

5. Type n and press ENTER.

6. Remove the Avamar Solaris Cluster Client software by typing:

pkgrm AVMRclusclnt

The following appears in the command shell:

The following package is currently installed:
AVMRclusclnt Avamar Cluster Client

(sparc) 5.0.100-199

Do you want to remove this package? [y,n,?,q]

7. Type y and press ENTER.

The following appears in the command shell:

## Removing installed package instance <AVMRclusclnt>

This package contains scripts which will be executed with super-user permission 
during the process of removing this package.

Do you want to continue with the removal of this package [y,n,?,q]

8. Type y and press ENTER.

The following appears in the command shell:

## Verifying package <AVMRclusclnt> dependencies in global zone
## Processing package information.
## Executing preremove script.
## Removing pathnames in class <syms>
## Removing pathnames in class <dirs>
## Removing pathnames in class <mans>
## Removing pathnames in class <libs>
/opt/AVMRclusclnt/lib/libstdc++.so.5
/opt/AVMRclusclnt/lib/libobk_avamar64.so
/opt/AVMRclusclnt/lib/libobk_avamar.so
/opt/AVMRclusclnt/lib/libgcc_s.so.1
/opt/AVMRclusclnt/lib
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## Removing pathnames in class <etcs>
## Removing pathnames in class <apps>
/opt/AVMRclusclnt/etc/stop.sh
/opt/AVMRclusclnt/etc/start.sh
/opt/AVMRclusclnt/etc/avagent.d
/opt/AVMRclusclnt/etc/AvamarClient-UpdateReplace.sh
/opt/AVMRclusclnt/etc
/opt/AVMRclusclnt/bin/unix.pin
/opt/AVMRclusclnt/bin/sbtscan
/opt/AVMRclusclnt/bin/oracle.pin
/opt/AVMRcluscl
nt/bin/avtar.bin
/opt/AVMRclusclnt/bin/avtar
/opt/AVMRclusclnt/bin/avscc
/opt/AVMRclusclnt/bin/avregister
/opt/AVMRclusclnt/bin/avoracle
/opt/AVMRclusclnt/bin/avclusuninstall
/opt/AVMRclusclnt/bin/avclusinstall
/opt/AVMRclusclnt/bin/avagent.bin
/opt/AVMRclusclnt/bin
/opt/AVMRclusclnt/AvamarClient-License.txt
## Removing pathnames in class <none>
## Updating system information.
Removal of <AVMRclusclnt> was successful.
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This appendix presents additional information about using the Avamar Solaris 
Client to protect Solaris Zones.

Important Terms and Concepts
This topic introduces and discusses important terms and concepts that you should 
be familiar with before attempting to deploy Avamar in a Solaris 10 Zones 
environment.

Solaris 10 Containers. As an integral part of the Solaris 10 operating system, 
Solaris Containers isolate software applications and services using flexible, 
software-defined boundaries. Solaris Containers allow many private execution 
environments be created within a single instance of the Solaris operating system. 
Each environment has its own identity, separate from the underlying hardware, 
yet behaves as if it is running on its own system, making consolidation simple, 
safe, and secure. 

Solaris 10 Zones. Solaris Zones are part of a Solaris Container, delivering 
security, application fault, and namespace isolation. A Solaris Zone is a virtual 
environment that has security and application fault containment, and its own 
name space that can be tailored to the application that will run in it.

Global and Non-Global Zones. There is always one zone designated as and 
named the “global zone.” Global zones provide a structure within which other 
“non-global” zones can be created. 

The global zone encompasses all processes running on the system, whether or not 
these processes are running within a non-global zone. 

NOTE:  The term “local zone” is specifically discouraged,
because in this context “local” is not an antonym of “global.” 
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Capabilities and Limitations

Installation Errors Can Occur with Older Version Software. If installing 
older versions of Avamar Solaris Client software in non-global zones, the following 
error might appear:

pkgadd: ERROR: postinstall script did not complete successfully

You can safely ignore this error (the software did install correctly). Furthermore, 
version 3.7.2.94 and later software does not return this error.

avagent Restart Limitation. Restarting the avagent process from the global 
zone forcibly terminates all avagent processes (both global and non-global), but 
only restarts the avagent process in the global zone. Therefore, if Avamar Solaris 
Client software has been installed in non-global zones, you must manually restart 
each avagent process in each non-global zone. Restarting the avagent processes 
directly from the non-global zone works as expected.

Installation and Configuration
You can install the Avamar Solaris Client software in the global zone or in 
individual non-global zones. The procedure is the same one presented earlier in 
this publication. The only difference is whether you begin the installation sequence 
from the global zone or from a non-global zone.

Installing Avamar Solaris Client software in the Global Zone

Log in as root 1. Open a command shell and log into as root.

2. Log into the global zone.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 

3. Perform the following installation tasks presented earlier in this 
publication:

(a) Downloading the Install Package (page 65)

(b) Installing and Registering the Avamar Solaris Client (page 66)

Installing Avamar Solaris Client software in a Non-Global Zone

Log in as root 1. Open a command shell and log into as root.

2. Log into the global zone.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 
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3. From the global zone, log into the desired non-global zone.

The shell prompt should change from “global#” to some other zone 
designation. 

4. Perform the following installation tasks:

(a) Downloading the Install Package (page 65)

(b) Installing and Registering the Avamar Solaris Client (page 66)

Ensure that All Non-Global Zone Configurations are 
Backed Up

Back up and restore of global zone data is performed using the same procedure  
presented earlier in this publication. Refer to Backup and Restore of AIX, FreeBSD, 
HP-UX, Linux, SCO and Solaris Clients (page 90) for additional information.

However, in order to successfully restore non-global zone data, a current copy of 
that non-global zone’s configuration must exist on the Avamar server. 

IMPORTANT:  Attempting to restore non-global zone data
without current zone configuration information might result
in loss of data.

There are two procedures for exporting and saving a non-global zone 
configuration:

• Manually Exporting and Saving a Non-Global Zone Configuration (page 
115)

• Using a Preprocessing Script to Automatically Export and Save Your Non-
Global Zone Configuration Each Time You Perform a Backup (page 116)

The advantage to the second method is that each time you perform a backup, the 
zone configuration will automatically be saved with that backup.

Manually Exporting and Saving a Non-Global Zone 
Configuration

Log in as root 1. Open a command shell and log into the global zone as root.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 

2. Print each non-global zone’s configuration and direct it to a file as follows:

zonecfg -z zone1 export > zone1.config

Where zone1 is the non-global zone configuration you want to back up.

3. Place this configuration file in a location that ensures it will be backed up 
the Avamar server the next time a backup is performed.

4. Repeat steps 2 thru 3 for each global zone you will be backing up.
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  115



 Ensure that All Non-Global Zone Configurations are Backed Up
APPENDIX C — SUPPORT FOR SOLARIS ZONES
Using a Preprocessing Script to Automatically Export and 
Save Your Non-Global Zone Configuration Each Time You 
Perform a Backup

The best practice for backing up your zone configuration is to create a 
preprocessing script that will export the zone configuration and save each time a 
backup is performed. 

Log in as root 1. Open a command shell and log into the global zone as root.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 

2. Use a Unix text editor to create a separate preprocessing script for each 
non-global zone in the /opt/AVMRclnt/etc/scripts directory.

For example, the following command creates the zone1_config.sh 
preprocessing script for the zone1 non-global zone:

vi /opt/AVMRclnt/etc/scripts/zone1_config.sh

Each script should contain the following entries:
#!/usr/bin/sh
zonecfg -z zone1 export > /zone_configs/zone1.config

Where zone1 is your non-global zone name.

3. Save your changes.

Next, you must create an Avamar dataset for each non-global zone you will 
be backing up.

4. Start Avamar Administrator.

5. Select Tools > Manage Datasets…

The Manage All Datasets window appears.
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6. Click New. 

The New Dataset dialog box appears.

7. Type a name for this new dataset.

IMPORTANT:  Do not use any of the following characters in
your dataset name: ~!@$^%(){}[]|,`;#\/:*?<>'"&.

8. Click the Source Data tab.

The Source Data tab is where you define a list of source data plug-ins that 
contribute data to this dataset. 

9. Select Enter Explicitly and Select Solaris File System from Select Plug-in 
Type list.

10.Select Select All Data for All Local File Systems.

11.Click the Options tab.

12.Select Include Advanced Options.

13. In the Pre Script Run user-defined script at beginning of backup field, type 
the name of the preprocessing script you created in steps 2 thru 3.

For example, zone1_config.sh.

14.Click OK.

The New Dataset dialog box closes.

15.Repeat steps 2 thru 14 for each non-global zone you will be backing up.
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  117



 Non-Global Zone Disaster Recovery
APPENDIX C — SUPPORT FOR SOLARIS ZONES
Non-Global Zone Disaster Recovery
As previously mentioned, restoring global zone data is performed using the same 
procedure presented earlier in this publication. Refer to Backup and Restore of 
AIX, FreeBSD, HP-UX, Linux, SCO and Solaris Clients (page 90) for additional 
information.

However, if performing disaster recovery of entire non-global zone, you must use 
one of the following procedures:

• Procedure 1: Restoring an Entire Non-Global Zone From a Global Zone Backup 
(page 118)

• Procedure 2: Restoring an Entire Non-Global Zone From a Non-Global Zone 
Backup (page 119)

TIP:  Sun Microsystems recommends using the first proce-
dure.

Procedure 1: Restoring an Entire Non-Global Zone From a 
Global Zone Backup

In order to completely restore a non-global zone from a global zone backup, you 
must first restore the zone configuration file to a temporary directory in the global 
zone, then restore the rest of the non-global zone. This requires two separate 
restore operations.

1. From Avamar Administrator, restore the zone configuration file a 
convenient temporary directory within the local zone.

/tmp is used as an example temporary directory for the remainder of this 
procedure.

IMPORTANT:  Do not restore any other files at this time.

Log in as root 2. Open a command shell and log into the global zone as root.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 

3. Type:

cd /tmp

4. Specify that the zone1.config file should be used recreating the zone by 
typing:

zonecfg -z zone1 -f zone1.config

5. Install the zone by typing:

zoneadm -z zone1 install
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6. In order to prevent the system from displaying sysidtool prompts on initial 
zone log in, delete the .UNCONFIGURED file by typing:

 rm /export/home/zones/zone1/root/etc/.UNCONFIGURED

7. Switch back to Avamar Administrator and restore the remaining non-global 
zone files and directories.

8. Be sure to include the --restoresystem advanced plug-in option.

Refer to your Avamar System Administration Guide for additional 
information about supplying advanced plug-in options.

9. Switch back to your command shell session.

10.After the restore has completed, boot up the zone by typing:

zoneadm -z zone1 boot

11.Confirm the zone is running by typing:

zoneadm list -cv

The following appears in your command shell:

12.Confirm you can log into the zone by typing:

zlogin zone1

Procedure 2: Restoring an Entire
 Non-Global Zone From a Non-Global Zone Backup

1. From Avamar Administrator, restore the zone configuration file a 
convenient temporary directory within the local zone.

/tmp is used as an example temporary directory for the remainder of this 
procedure.

IMPORTANT:  Do not restore any other files at this time.

Log in as root 2. Open a command shell and log into the global zone as root.

NOTE:  The “global#” prompt indicates that you are suc-
cessfully logged into the global zone. 

3. Type:

cd /tmp

4. Specify that the zone1.config file should be used recreating the zone by 
typing:

zonecfg -z zone1 -f zone1.config

ID NAME STATUS PATH BRAND IP

0 global running / native shared

4 zone1 running /zones/zone1 native shared
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5. Install the zone by typing:

zoneadm -z zone1 install

6. In order to prevent the system from displaying sysidtool prompts on initial 
zone log in, delete the .UNCONFIGURED file by typing:

 rm /export/home/zones/zone1/root/etc/.UNCONFIGURED

7. Boot up the zone by typing:

zoneadm -z zone1 boot

8. Confirm the zone is running by typing:

zoneadm list -cv

The following appears in your command shell:

9. Log into the zone by typing:

zlogin zone1

10.Reinstall the Avamar Solaris Client software in the non-global zone and 
register it with the Avamar server.

NOTE:  It might be necessary to deactivate this non-global
zone client instance from the Avamar server in order to suc-
cessfully reactivate it with the Avamar server.

11.Switch back to Avamar Administrator and restore the remaining non-global 
zone files and directories.

NOTE:  Sun Microsystems recommends that no shared LOFS
file systems be restored from within a non-global zone. By
default, Avamar will not traverse any LOFS or NFS file sys-
tems during backups, so this should not be an issue.

ID NAME STATUS PATH BRAND IP

0 global running / native shared

4 zone1 running /zones/zone1 native shared
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APPENDIX D — VMWARE GUEST-LEVEL BACKUP AND
RESTORE

Avamar currently offers three different methods to protect data residing in 
VMware environments:

Guest-level backup and restore, which involves installing Avamar client 
software inside each virtual machine.

Integration with VMware Image Backup, which involves installing Avamar 
client software on a proxy server.

Integration with VMware Consolidated Backup (VCB), which involves installing 
Avamar client software on the VCB proxy server.

ESX Server backup and restore, which involves installing Avamar client 
software directly on the ESX Server.

Only guest-level backup and restore is discussed in this publication because the 
other three methods require advanced VMware knowledge, scripting ability or 
additional hardware.

For additional information about integrating Avamar with VMware Image Backup 
or VCB, or directly backing up ESX Servers, refer to your Avamar System 
Administration Guide.

Advantages. Guest-level protection is the most common data protection 
method because of the many advantages it offers: 

• Highest level of data deduplication, resulting in maximum storage 
efficiency

• Guest-level backup easily fits into most existing backup schemes; day-to-
day backup procedures do not change

• Support for fast partial restores of individual directory (folder) or files
• Optional support for application-level support for DB2, Exchange, Oracle and 

SQL Server databases
• No advanced scripting or VMware knowledge required

Considerations. The only significant consideration to this approach is that 
although file and directory restores are a simple one-step process, full system 
recovery is a two-step procedure in which you first load a known-good operating 
system image inside the virtual machine, then restore the unique data from the 
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guest-level backups stored on the Avamar server. Performing full system restores 
is beyond the scope of this publication. Instead, refer to your Avamar System 
Administration Guide for additional information.

Installation and Configuration. In order to implement guest-level backup, 
you simply use the procedures found elsewhere in this publication to install the 
correct Avamar client for each virtual machine in exactly the same manner as you 
install the Avamar client software on physical machines. No advance scripting or 
configuration is needed.

On-Demand Backups and Client-Initiated Restores. Basic on-demand 
backups and client-initiated restores can be performed using the procedures found 
elsewhere in this publication. Use the correct procedure for your computing 
platform.
AVAMAR BACKUP CLIENTS 5.0 • USER GUIDE  122



APPENDIX E — SUPPORT FOR NOVELL NSS VOLUMES

Novell Storage Services (NSS) is the file system originally created for NetWare.

With the introduction of OES Linux, Novell made its common services available on 
to this operating system. By doing so, it has provided an easier migration path for 
customers wishing to deploy Linux in their environments. Therefore, NSS volumes 
can be created on and managed from Linux.

Novell Open Enterprise Server (OES) Linux has introduced a new feature, XAttr 
Extension for Novell Storage Services (NSS), which allows easy backup and 
restore of NSS file metadata.

Requirements
In order to properly back up Novell OES Linux SP2 NSS volumes (including the 
metadata) using the Avamar Linux Client, the following additional requirements 
must be satisfied:

1. Linux User Management (LUM) and Novell Storage Services (NSS) must be 
installed and configured.

2. The OES Linux server must be patched as follows:

(a) Upgrade the kernel to 2.6.5-7.282 or higher.

(b) Install/upgrade to km-nss-4.9.26-0.1.i586.rpm or higher.

(c) Install/upgrade to novell-nss-4.9.23-1.i586.rpm or higher.

(d) Install/upgrade to novell-sms-zapishim-2.6.5_7.282-1.0.5.i586.rpm or 
higher.

3. NSS must be configured with the following switches either through 
nssstart.cfg or nsscon:

nss /ListXattrNWMetadata

nss /CtimeISMetadataModTime
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IMPORTANT:  Subsequent releases of OES Linux might
require less manual configuration than what is described in
the previous procedure (that is, you might only need to con-
figure LUM and NSS). However, EMC strongly recommends
that you refer to information found on www.novell.com in
order to confirm precisely which configuration tasks need to
be performed on these servers running any subsequent OES
Linux release.

Capabilities and Limitations
In order to maintain data integrity of transactional systems that use files hosted 
on NSS volumes, you must shut down those applications prior to initiating a 
backup.

There is no snapshot support for NSS on OES Linux.

The OES Linux local eDirectory database is not backed up.

Additional Resources

TOPIC LOCATION

Novell Storage 
Services

www.novell.com/documentation/oes/pdfdoc/nss_enu/
nss_enu.pdf

Linux User 
Management

www.novell.com/documentation/oes/pdfdoc/lumadgd/
lumadgd.pdf
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APPENDIX F — NETWARE APPLICATION NOTES

This appendix discusses various topics that are unique to using Avamar in Novell 
NetWare environments.

Pool Snapshots. Avamar uses the Novell Storage Services (NSS) pool snapshot 
feature, which makes a point-in-time snapshot of a data pool available for backup. 

The snapped pool name will always be the concatenation of the string “AV_” and a 
unique hexadecimal value such as “8F5AA0A0.” Therefore, if the volume to be 
backed up is named DATA_VOL and it belongs to the DATA pool, the snapped pool 
name would be generated as AV_8F5AA0A0. Additionally, the snapped volume 
name would be DATA_VOL_SV.

Note that if a previous pool snapshot of DATA exists and was created by another 
application or manually from the server console, the name would be 
DATA_VOL_SV001. The volume name suffix is determined and handled by NSS.

You can view pool information by typing nss /pools at the server console prompt. 
Space information can be viewed by typing nss /spaceinformation. For a list of 
other NSS console commands, type nss /?.

In the backup Advanced Options, you have the option to specify the stored-on 
pool for the snapshot. The stored-on pool is where the pool snapshot is actually 
kept. As writes are made to the original pool, the original block data is first copied 
to the stored-on pool. 

Novell recommends that 10-20% of the original pool size is available on the disk 
used for the snapshot pool. The actual space needed is unique to each 
environment and is affected by the write activity to the original pool. Novell also 
recommends that the stored-on pool is different from the original pool and, if 
possible, that it also resides on a different disk.

IMPORTANT:  If a pool snapshot exists, the same stored-on
pool must be used. If unsure, use iManager to determine the
correct stored-on pool to type in the backup options. EMC
strongly recommends not creating or removing any pool
snapshots during backup operations.
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In order to ensure data integrity, the data pool must first be made quiescent. This 
briefly prevents new writes from taking place once the present transactions are 
completed.

IMPORTANT:  Although NSS takes steps to complete all
outstanding transactions before creating the pool snapshot,
there might still be situations where data of transactional
systems is compromised. If an application is not snapshot-
aware, it cannot respond to the NSS notification of a pending
snapshot. Otherwise, it would flush its cache, commit pend-
ing writes among other steps to make itself quiescent thus
ensuring the integrity of its data. If your transactional sys-
tems are not snapshot-aware, it is recommended to shut
them down prior to the backup.

Go to www.novell.com for additional information about Novel Storage Services 
(NSS) and pool snapshots.
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